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DOCUMENTATION AND SOFTWARE UPDATE
FOR THE i-STAT SYSTEM: OCTOBER 2006

In addition to important updates to documentation about the i-STAT® System, this package contains the necessary
items to perform the required software upgrades on your i-STAT System. ltems enclosed are detailed in the table
below. Please follow instructions carefully. Thank you for your prompt attention in performing this upgrade.

Contact i-STAT Technical Support at 1-800-366-8020, option 1, if you have any questions or need further

assistance.

. SENT TO
K
B 2519w
S |g8lak
ITEM COMMENT ® E: 4
Add/Delete sheet, -STAT 1 System Manual List§ which sections should be replaced with updated X
sections.
Add/Delete sheet, i-STAT System Manual Llstg which sections should be replaced with updated X
sections.
Cartridge and Test Information Sheet for S . .
lonized Calcinin New or revised information that should be retained. X
Cartridge and Test Information Sheet for Y ; :
B-Type Natriuretic Peptide /| BNP New or revised information that should be retained. X
TECh.mca' Bulletin: The -STAT BNP New or revised information that should be retained. X
Cartridge
i-STAT and i-STAT 1 System Manual: - ) .
introduction ts e CTI Sestion New or revised information that should be retained. X
Eﬁ:ﬁg System Manual Section 12: Quality New or revised information that should be retained. X
i-STAT System Manual Section 13: N . .
Calibration Verification New or revised information that should be retained. X
i-STAT System Manual Section 18: Central T ; \
Data Station 5 New or revised information that should be retained. X
i-STAT 1 System Manual Section 10: " ; ]
Sample Collection New or revised information that should be retained. X
i-STAT 1 System Manual Section 14: —— : ‘
Quality Control Ngw or revised information that should be retained. X
i-STAT 1 System Manual Section 15: T : ;
Calibration Verification New or revised information that should be retained. X
i-STAT 1 System Manual Section 22: - ) .
Central Data Station 5 New or revised information that should be retained. X
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DOCUMENT COMMENT & 8
Control and Calibration Verification Value Directs customer to www.abbottpointofcare.com for X
Assignment Sheet Notice printing new value assignment sheets.
Product Update: JAMS054 / JAMS121/ Describes changes in new software and summarizes X
HPCA054 updates to documentation.
Disk: i-STAT Software for Analyzers One disk contains all versions of software. X
. ol : For use in updating software using a computer with
ézg\;‘\g‘;&l Sl RISt e Windows 85 or higher. These instructions must be X
used for updating i-STAT 1 Analyzers.
Technical Bulletin: Instructions for Updating | For use in updating software from a computer with X
Software: Jammit Utility Windows 3.1.
GConfiimation Posteard Complete and return to i-STAT after upgrade has X

been performed.

i-STAT is a registered trademark of Abbott Laboratories.
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iI-STAT®
PRODUCT UPDATE

SOFTWARE AND CARTRIDGE TEST INFORMATION
UPDATE: OCTOBER 2006

This update includes new software for the i-STAT 1 Analyzer, i-STAT Portable Clinical Analyzer and Philips
Medical Systems Blood Analysis Module. The appropriate materials required for your institution to perform
the update are included.

This is a mandatory update. If you did not receive a disk or CD-ROM with the correct software for your
analyzers (see list below), please call to request one. In the US, call i-STAT Technical Support at 800-366-
8020, option 1. Outside the US, please contact your local support representative.

The correct version of software and CLEW to install in your analyzers is listed below.

STANDARD SOFTWARE

i-STAT Portable Cli;ﬁcal i-STAT 1 Analyzer Blood Analysis Module
Analyzer
JAMS054 & CLEW A12 JAMS121 & CLEW A12 HPCAO054 & CLEW H12
Japan: JAMS054 & CLEW C12 | Japan: JAMS121 & CLEW A12 | Japan: HPCA054 & CLEW J12

Expiration Date Please note that the current software expires 13 December 2006.

Fifteen days before the software expires, a message will be displayed to alert
the user of the pending expiration date. If this update is not performed by 13
December 2006, the analyzer and Blood Analysis Modules will display “INVALID
OR EXPIRED CLEW - SEE MANUAL"” (quality check code 12).

The new software expires 20 June 2007.

Abbott
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Portable Clinical
Analyzer

i-STAT 1 Analyzer

i-STAT and i-STAT 1
System Manuals

The application of the “CPB Always” setting will be removed when running
Proficiency cycles. When an i-STAT Portable Clinical Analyzer is configured for
“CPB Always” and a user runs a Proficiency cycle, the “CPB Always” setting
will be ignored, and the cycle will run with the default setting of “Prompt CPB”,
which does not apply the CPB correction unless the user consciously navigates
to the analyzer Chart Page and selects “CPB” as the Sample Type

The i-STAT 1 Analyzer will not allow CPB to be selected when running Proficiency
cycles. When an i-STAT 1 analyzer runs a Proficiency cycle, that cycle will
run with “CPB Never” configuration, regardless of the analyzer’s current
customization setting. It will not be possible to select CPB as a Sample Type.

The i-STAT 1 Analyzer will now store the Operator ID with Internal Simulator
records, even if the Operator ID entry is completed following the internal
simulator cycle.

The Expected Values table of the Introduction to the Cartridge and Test
Information Section for both the i-STAT and i-STAT 1 System Manuals has been
updated to reflect a change in the BNP reportable range to 15 - 5000 pg/mL (ng/
L}.

The Sample Collection, Quality Control and Calibration Verification sections in
the i-STAT 1 System Manual have been updated with information regarding the
use of the new BNP cartridge.

a). The Sample Collection section indicates that the use of glass vessels
is not recommended because the BNP molecule has been shown to
be unstable in glass tubes.

b). The Quality Control and Calibration Verification sections contain
updated mixing recommendations for the BNP control and calibration
verification material.

The Quality Control and Calibration Verification sections of both the i-STAT and
the i-STAT 1 System Manuals have been updated with information regarding
the room temperature storage of the RNA® Medical Controls and Calibration
Verification material for hematocrit.

Section 18 of the i-STAT System Manual and Section 22 of the i-STAT 1 System
Manual have both been updated to include all of the CDS Version 5 changes
from October 2004 to the present.

Please replace your corresponding sections of the System Manual with these
new updated versions.

Central Data Station
Version 4

Central Data Station
Version 5

There is no update to CDS Version 4.

Update your CDS Version 5 program to Version 5.20 by using the CD included in
this software update packet. This is a mandatory update.

This update includes performance enhancements required to maintain
compatibility with new cartridges.

Art: 717185-00A Rev. Date: 08/23/06



i-STAT DE

There is no update to the i-STAT/DE.

CLEW Update

The i-STAT System is designed to eliminate operator influence on delivered
results. With the exception of the immunoassay cartridges, the user is not
required to enter lot-specific calibration information into the instrument. The
micro-fabricated sensor technology produces very repeatable devices from lot
to lot which allow the Analyzers to use the same set of standardizing values for
extended periods of time.

Nevertheless, continuous manufacturing process improvements made by i-STAT
necessitate re-establishing standardization values from time to time to maintain
long-term consistency. This is equivalent to adjusting calibration on a traditional
analyzer. It has been our practice to accomplish this with periodic releases of
software. This new CLEW re-establishes the standardization and incorporates
refinements to the internal quality monitoring system.

Future shipments of cartridges may require the installation of this software
prior to the use of the cartridges. Failure to update prior to using these
cartridges will result in quality check code 69, “CARTRIDGE TYPE NOT
RECOGNIZED".

This software supports all current non-expired cartridges.

An updated ionized calcium CTI sheet is enclosed. Recent studies indicate that
falsely elevated ionized calcium results do not occur with cartridge freezing.
Therefore, this statement in the Factors Affecting Results section of the CTI
sheet has been removed. However, the general recommendation against freezing
cartridges remains.

For i-STAT 1 Analyzer customers, a new CTI sheet for B-Type Natriuretic Peptide/
BNP is also enclosed.

i
.

For i-STAT 1 Analyzer customers, a new Technical Bulletin is enclosed which
describes the use of the new BNP cartridge.

i

i-STAT is a registered trademark of Abbott Laboratories.
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i-STAT®
TECHNICAL BULLETIN

UPDATING ANALYZER SOFTWARE

JAMMLITE UTILITY

The JammlLite Utility must be used to update software in the i-STAT®1 Analyzer and can be used to update
the i-STAT Portable Clinical Analyzer and the Blood Analysis Module. The JammlLite procedure is simple
with just one screen for all analyzer types and software versions.

To use this utility, you must have a computer with Windows® 95 or higher. An i-STAT Central Data Station
Version 5 or a Point of Care Central Workstation meet this requirement and can be used. An i-STAT/DE
server is not recommended for use with this utility.

If this is the first time you are updating your analyzer, follow the Detailed Procedure. If you just need
reminders, follow the Summary of the Procedure.

SUMMARY OF THE JAMMLITE PROCEDURE

0

)
«

®

Check battery voltage . 4 o
Save the data on Portable Clinical Analyzers

Disable Customization on the Central Data Station 2 2
Shut down all programs on the computer 3 2
Connect an IR Link or Downloader* to the computer 4 3
Access the C:\> prompt 5 4
Transfer the files from the JAMS disk to the computer 6 4
Access the JammLite Utility 7 5
Select the instrument (analyzer) type to be updated 7 5
Select the local port or select TCP\IP and enter the IP address 7 5
Select the Application software and CLEW 7 5
Click on Update and follow the directions on the screen 7 6
DO NOT move analyzer during update 7 6
Click on Close 7 6
Click on Exit or X in upper right corner of screen 7 6
Re-start the CDS, update CLEW, re-eanable Customization 8 6
Insert an Electronic Simulator into each updated analyzer 9 7

It is not neccessary to connect a serial Downloader if using network protocol to update i-STAT 1 Analyzer.

Abbott
Point of Care

Abbott Point of Care Inc. ¢ 104 Windsor Center Drive ¢ East Windsor, NJ 08520 ¢ (800) 366-8020
Art: 714329-00J Rev. Date: 08/14/06



DETAILED JAMMLITE PROCEDURE

Step (1) Save Stored Results & Check Battery Voltage

Save Data: All test records are erased in the i-STAT Portable Clinical Analyzer
(series 200) when the application software is updated. Download each analyzer
to the Central Data Station (CDS) program or ensure that all test records have
been transcribed before updating a Portable Clinical Analyzer. Test records are
not erased from the i-STAT1 Analyzer (series 300).

* There are two types of software in the analyzers: application (JAMS)
and CLEW.

¢ The Product Update lists the software that is to be updated.

* Test records will not be erased if only the CLEW software is updated.

Check Battery Voltage: Analyzers consume power during the software up-
date. For the software update, the battery voltage should be well above the
7.5V point at which the low battery message is displayed.

Step (2) Disable Customization on CDS

If you do not use Customization or Customization is disabled, skip this step.
If you use Central Data Station Version 5 and your CDS is on Version 5.18a or
higher, skip this step.

If you are not sure if Customization is disabled, follow the steps below. The steps
to disable customization differ for the Central Data Station Version 4 and Central
Data Station Version 5. If you are not sure which CDS you have, click Help on
the main menu bar, then click on About....

Central Data Station Version 4:

1. Click on the i-STAT Analyzer Customization Profile Utility icon or
access by clicking Programs and i-STAT CDS.

Type in the Password. The default password is istat.
Click on File on the menu bar.

Click on Disable Customization.

G - e (Gl D

Click Yes to the confirmation messages and the Utility will close.

Central Data Station Version 5:

1. Click on Administration in the main menu bar.

2. Click on Customization.

3. Type in the Password. The default password is istat.
4

Click off the checkmark in the box beside Enable Customization at the
top left of the window.

Step (3) Shut Down All Programs
Exit the CDS and all other open programs.
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Step (4)

Connect the IR Link and/or Downloader

IR Link connection:

* If using a Central Data Station Version 5, a Central Data Station
Version 4 with digiboard, or any other computer using Windows 95
or above, connect the IR Link to a 9 pin COM port using an i-STAT
Software Update Kit as illustrated below.

L] D-Connector plugs
[/ into the Serial Port of
“W~.. /aptop or desktop computer.
~ S
e ~
MiniDin Cornector

plugs into the keyboard port of ™
the laptop or desktop computer

~

R4S o
Ry,
Modyys, Dats g: ble

Keyboard Cable with
MiniDin Connector

* [fusing a Central Data Station Version 4 with quad cards: Connect the
IR Link to COMS5 on the back of the CDS using a Modular Data Cable
(i-STAT grey flat cable with RJ45 connectors). COMS5 is first port from
the inside on the lower row.

Blood Analysis Module connection:

¢ |f using a Central Data Station Version 4, connect the BAM to COM5
on the back of the CDS using a Modular Data Cable (i-STAT grey flat
cable with RJ45 connectors).

* If using a Central Data Station Version 5 or another computer, connect

the BAM to a 9 pin COM port using the D-Connector and Mini Din
Connector from an i-STAT Software Update Kit.

Note: Do not connect the BAM until instructed to do so by the JammlLite
program.
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Step (5)

Step (6)

Serial Downloader connection:

® Connect a serial Downloader to a COM port using a DB9-DB9 Null
Modem cable and plug the Downloader's power adapter into a wall
outlet.

Null Modem Cable
connected to Serial Port

Power Supply
with 12V = 3.0A
AC Adapter

Network Downloader connection:

* Connect a network Downloader to the network using a network patch
cable and plug the Downloader’s power adapter into a wall outlet.
The computer must also be connected to the network. The computer
must support the TCP/IP network protocol.

Access the Command Prompt
e (Click Start in the lower left corner of the window.

s (Click Run.

* Type: command and press the Enter key.

Note: If you do not have access to the Run command, contact your Point-
of-Care Coordinator or Information Technology (IT) department.

Transfer the Files

Place the JAMS diskette into the A:drive. At the Command prompt, type A:
transfer and press the Enter key.

Art: 714329-00J Rev. Date: 08/14/06



Step (7)

Using the JammlLite Utility

15

At the C:\>bins prompt, type jammlite and press the Enter key. The
following screen will be displayed with the new application and CLEW.

X.X is the current version of JammlLite software.

2

Note:

Select the appropriate instrument from the Instrument drop-down list.

FSTAT 300 Analyzer
+STAT 200 s
TaT 30U dnak

i-STAT 200 Analyzer is the Portable Clinical Analyzer and the i-STAT
300 Analyzer is the i-STAT 1 Analyzer.

Select the port for the instrument being updated from the “Port” drop-
down list. The JammlLite program will list only available ports on the
computer. For updates using a network Downloader, select TCP/IP.
(The TCP/IP option is available only if i-STAT 300 is selected from the
“Instrument” drop down list.) Enter the IP address of the Downloader
in the “IP Address” box.

Select the appropriate Application and CLEW from the Application and
CLEW drop-down lists. Refer to the update package for the correct
Application and CLEW. If the update is for CLEW only, select None for
Application. Note that there are different application versions for the i-
STAT 1 Analyzer, the Portable Clinical Analyzer and the Blood Analysis
Module. JammLite will display all application software and CLEW
appropriate for the selected instrument.

Art: 714329-00J Rev. Date: 08/14/06 5



Step (8)

Click on the Update button to start the update. Appropriate
instructions will be displayed. Follow the directions on the screen.
The selected application and CLEW will be displayed on the Update
Line.

During the update, do not move the analyzer or unplug the Blood
Analysis Module until a screen is displayed indicating the update was
successful.

Click on Close. The JammlLite program will return to step 7 to allow
any selections to be changed before starting another update.

When all analyzers have been updated, click on Exit or the X in the
upper right corner of the DOS window.

Restarting the Central Data Station

If using a Central Data Station, re-start the software, update the Customization
Profile(s) with the new CLEW and enable Customization if desired.

Central Data Station Version 4:

1.

9.

RN B G W

Click on the i-STAT Analyzer Customization Profile Utility icon or
access by clicking Programs and i-STAT CDS.

Type in the Password. The default password is istat.

Click on Setup Mode.

Click on NEXT for the Language window.

Click on the new CLEW in the CLEW window and click on NEXT.
Click on NEXT in the Unit Set window.

Click on FINISH in the Preference window.

Click on FILE and Exit Program or click on the x in the upper right
corner of the Utility window.

Click on the Central Data Station icon.

Central Data Station Version 5:

2

Ny BN s e 19

Click on the Central Data Station icon.

Click on Administration.

Click on Customization.

Type in the Password. The default password is istat.

Click the i-STAT Analyzer CLEW button.

Click the new version of CLEW and click OK.

If “Use Default Profile” is not check-marked beside any localization-
based customization profiles, double click the box with the CLEW
under the i-STAT Analyzer column (or Agilent BAM CLEW) and click
the new version of CLEW.

Click a checkmark in the box beside Enable Customization at the top
left of the window.

Click the x in the upper right corner of the Customization window to
close it.

Art: 714329-00J Rev. Date: 08/14/06



Step (9) Verifying the Update

Run an external Electronic Simulator on updated analyzers and check the
Analyzer Status page for the new Application software and/or CLEW.

TROUBLESHOOTING
PROBLEM RECOMMENDED ACTION I

The Com port to be used for the update is not Exit the JammLite program and ensure that

listed in the Port List there are no other programs running which
may be using the port (such as the Central
Data Station). Restart the JammLite program
to determine if the port is now listed.

A message appears on the screen that the Verify that no other programs are using the

port specified for the update could not be port and that the correct port was selected.

opened.

A message appears on the screen that the Verify that all other programs are closed and

specified application file could not be opened, that the proper application was selected before

has an error, or is not a valid application file. re-attempting the update.

A message appears on the screen that the IR Verify that the IR Link is connected to the COM

Link could not be configured to perform the port, that the LED on the IR Link is red, and

application update. that the proper port is selected.

A message appears on the screen that Ensure that the instrument is located properly

there was an error encountered during in the IR Link or Downloader, and this it is not

communication with the analyzer. removed before the update is completed.

A message appears on the screen that the Ensure that all other programs are closed and

specified CLEW file could not be opened, has that the correct CLEW is selected before re-

an error, or is not a valid CLEW file. attempting the update.

A message appears on the screen that the IR Verify that the IR Link is connected to the COM

Link could not be configured to perform the port, that the LED on the IR Link is red, and

CLEW update. that the proper port is selected.

A message appears on the screen that the Verify that the Downloader is connected to the

Downloader could not bé configured to COM port, the Downloader is powered, and

perform the update that the proper port is selected.

A message appears on the screen indicating Select an Application and/or a CLEW prior to

that nothing was selected for the update. clicking on the Update button.

Quality Check Code 13 - Invalid or Expired CLEW after on-line customization is restored

If this quality check code occurs after successfully downloading new software and restoring on-line
customization, the CLEW has not been updated to the new version in the Customization Profile. Update
CLEW in the customization profile(s) and download the analyzers. The new CLEW will be installed in the
analyzers.

Unsuccessful with Windows 95

Some computers with Windows 95 will not run JammLite. In this case, Jammit must be used to update
analyzers. Before accessing the Jammit Utility, the computer must be rebooted.

Art: 714329-00J Rev. Date: 08/14/06 T



ANALYZER-TO-ANALYZER SOFTWARE UPDATES

i-STAT 1 Analyzer

1

Any updated analyzer can be used as the sending analyzer. Select the Utility option under the
Administration Menu on the sending analyzer. The Utility menu can be password protected. Enter the
password or press the Enter key if no password has been specified. From the Utility Menu select 1-
Send Software. Select 1 - JAMS and CLEW or 2-CLEW as required for the update. The message
“Waiting to Send” will be displayed.

Ensure that the receiving analyzer is off.

Place the sending and receiving analyzers facing each other on a flat surface about 30cm (1 foot)
apart and align their IR windows. Move one analyzer toward the other until the message “Sending...”
is displayed on the sending analyzer and a scrolling banner appears on the receiving analyzer.

Do not move the analyzers until the “Sending...” message is removed from the sending analyzer’s
display. The sending analyzer will return to the Send Software option and will display the result of the
last software update as "Successful” or “Unsuccessful.”

Select the Analyzer Status option under the Administration menu on the receiving analyzer and check
that the new JAMS and/or CLEW are listed.

i-STAT Portable Clinical Analyzer

1

Any updated analyzer can be used as the Sending Analyzer. Run the external Electronic Simulator on
the Sending Analyzer.

Transmit all data from the analyzer being updated (the Receiving Analyzer) to the Central Data Station.
Data stored in the handheld analyzer will be lost after an application software update.

With the Simulator test results showing on the display of the Sending Analyzer, press and hold the DIS
key and press the soft key for MENU. This displays the Utility Menu.

In the Utility Menu, select 3 - Send Software. The display will show the JAMS version and the CLEW
in this analyzer. Verify that these are the appropriate versions. The analyzer screen will also say
"Waiting to send".

Set both analyzers on a flat surface and align the Infrared Light-Emitting Diode (IR LED) windows so
they directly face each other. (Refer to the analyzer picture on page 2-1 of the i-STAT System Manual
for the location of the IR LED.)

On the Receiving Analyzer, make sure the display is off. Press and hold the * key and press the DIS
key. Thé Sending Analyzer will begin sending software to the Receiving Analyzer. The display on the
Sending Analyzer will change from "Waiting to send" to "Sending...", and a countdown bar will be
displayed.

Note: Do not move the analyzers while the software is being sent.

When the display of the Sending Analyzer changes back to the Electronic Simulator result, the
sending of software is complete. Do not press the DIS key on the Receiving Analyzer. Run the
Electronic Simulator on the Receiving Analyzer.

To update software in another analyzer, repeat these instructions from Step 2.

PERFORMING A JAMS AND CLEW UPDATE ON AN i-STAT 1 ANALYZER USING THE
CUSTOMIZATION WORKSPACE

1.

Transfer the Files

* Place the JAMS diskette into the A: drive.
e (Click Start = Run...
e Type: a:transfer and press the Enter key.

Note: |If you do not have access to the Run... command, contact your Point-of-Care Coordinator

or Information Technology (IT) department.
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Start the Central Data Station Application (if not already open)

Click on the Central Data Station icon.

Access the Customization Workspace

Click on Main =» Open Administration Function =) Customization
Type in the Password. The default password is istat.

Enable Customization

If the Enable Customization box is not already checked, click the box next to this listing.

Under the “Location-based customization profile:” section, make sure Enable Updates is
checked for every location from which you wish to perform software updates on your i-STAT 1
Analyzers.

Select the Desired Analyzer CLEW and i-STAT 1 Software

Under the “Default customization profile:” column, click on the i-STAT Analyzer CLEW button.
Click the new version of CLEW and click OK.

Under the “Default Customization profile:” column, click on the i-STAT 1 Software button.
Click the new i-STAT 1 software file and click OK.
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Update the Software in the i-STAT 1 Analyzer

Go to the location where the i-STAT 1 Analyzers you wish to update are located.
Press the On/Off button on the analyzer to turn the display on.
Press the Menu key to bring up the Administration Menu.

Press 7 for Utility. The Utility menu may be password protected. Enter the password or press
the Enter key if no password has been specified.

From the Utility Menu, select 3-Receive Software. The “Waiting to Send” message will appear
on the analyzer display.

Place the analyzer in the downloader or downloader/recharger. A Communication in Progress
message will appear on the screen. After this message disappears, the analyzer display will
stay blank for approximately 5-10 seconds. Please note that this blank screen is normal
analyzer behavior during this part of the procedure.

A scrolling bar will then appear on the analyzer display. This bar indicates that the software

is uploading into the analyzer. Do not move the analyzer while the scrolling bar appears on
the display screen. When the upload process is complete, the scrolling bar will disappear and
the analyzer display will again go blank for approximately 5-10 seconds. Please note that this
blank screen is normal analyzer behavior during this part of the process.
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¢ A Waiting to Send message followed by a Communication in
Progress message will then appear on the analyzer display. After
these messages disappear, the analyzer display will go blank, and
the update process is complete.

7. Verify the Update
¢ Run an external Electronic Simulator on updated Analyzers and

check the Analyzer Status page for the new Application software
and/or CLEW.

i-STAT is a registered trademark of Abbott Laboratories.
Windows is a registered trademark of Microsoft Corporation.
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i-STAT®
TECHNICAL BULLETIN

Updating Analyzer Software: JAMMIT Utility

This Technical Bulletin contains the instructions for updating application software and CLEW in the

i-STAT Portable Clinical Analyzer and Philips Medical Systems Blood Analysis Module. Unless you have a
Central Data Station 3.1 or a PC with a Windows software below 95, we recommend that you use the JAM-
MLITE Utility rather than this JAMMIT Utility to update your analyzers and Blood Analysis Modules. If you
have any questions, please call i-STAT Technical Support at (800) 366-8020.

SETTING UP THE COMPUTER

If using an i-STAT Central Data Station

if using an i-STAT Central Data Station (CDS) to update the Analyzers, follow the steps below for setting up
the computer:

1 If updating handheld analyzers, transmit all data from the handhelds to the CDS. Data stored in
a handheld analyzer will be lost after an application software update.

Attention: [f the Analyzer Customization Profile Utility is enabled in your Central Data Station,
disable it prior to starting this process. The profile can be saved for restoration.
For additional information on doing this, refer to the i-STAT Technical Bulletin,
“Instructions for the Analyzer Customization Profile Utility” or in newer manuals,
“Customization Utility” in the Central Data Station 4 section.

Once Analyzers are updated, the function to restore the profile can be used to re-enable on-line
customization, if desired. However, be sure to first select the new CLEW in the profile.

2 Connect a Modular Data Cable to the COM5 port on the back of the CDS. If your Central Data
Station has one quad card (four ports for data cables), COM 5 is the innermost port closet to
the fan. If your CDS has two quad cards, COM 5 is the innermost port on the bottom row of
ports. If updating handheld analyzers, connect an IR Link to the opposite end of the cable.

3 Click on Exit to close the Central Data Station application.
4 Exit the Windows application following the instructions below for your platform:
Windows 3.1 platform: Click on FILE and then EXIT in the Program Manager.
Windows 95/98 platform: Click the Start button, select Shut Down..., then select Restart in DOS mode.

Abbott
Point of Care
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Windows NT platform: Click the Start button, select Programs, then select Command Prompt.

With Windows 95/98 and NT platforms, you will be at the C:AWINDOWS prompt on exiting. Return to the
root directory by typing cd\ and pressing the Enter key.

Place the JAMS diskette into the A: drive.

At the C:\> prompt, type A:TRANSFER and press the ENTER key. Wait for the DOS prompt C:\BINS> to ap-
pear. Ignore any “File Not Found” or “Directory Already Exists” messages that may appear.

At the CABINS> prompt, type JAMMIT and press the ENTER key. The i-STAT Configuration Utility will ap-
pear.

Proceed with the section of this document titled “Downloading to an Analyzer”.

If you are using any other IBM PC compatible/ Point-of-Care Central Workstation
If using any other IBM PC compatible to update the analyzers, follow the steps below for setting up the computer:

10

If updating handheld analyzers, transmit all data from the handhelds to the CDS. Data stored in a handheld
analyzer will be lost after an application software update.

Connect a Modular Data Cable to one of the 9-pin connector COM ports on the PC using the power adapter
according to instructions supplied with it or the picture below. If updating handheld analyzers, connect an IR
Link to the opposite end of the cable.

Exit all applications. You must be at the MS DOS prompt. (See Step 4 under “If Using an i-STAT Central Data
Station.”)

Place the JAMS diskette into the A: drive.

At the C:\> prompt, type A:TRANSFER and press the ENTER key. Wait for the DOS prompt C:\BINS> to ap-
pear. Ignore any “File Not Found” or “Directory Already Exists” messages that may appear.

At the C:\BINS> prompt, type JAMMIT and press the ENTER key. The i-STAT Configuration Utility will ap-
pear.

Using the UP/DOWN arrow keys, highlight Utility Setup and press the ENTER key.

Using the UP/DOWN arrow keys, highlight COM Port. Using the RIGHT/LEFT arrow keys, select 1 or 2, de-
pending on where the 9-pin connector is connected.

Using the UP/DOWN arrow keys, highlight Return to Main Menu and press the ENTER key.

Proceed with the section of this document titled “Downloading to an Analyzer”.

D-Connector plugs RJ45 to RJ45
| into the laptop or Modular Data
| deskfop computer. Cable

IR Link:

MiniDin Connector
plugs into the keyboard
port of the laptop or

desktop computer Keyboard MiniDin

/ Connector

— Keyboard Cable
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DOWNLOADING SOFTWARE TO AN ANALYZER

Downloading to a handheld analyzer
Follow the steps below to download software to a handheld analyzer:

1 Highlight Software and press the ENTER key. The window Select Files to Download appears.
The menu items Application and CLEW will automatically be set to the newest version.

2 Confirm the setting for Application and CLEW against the Product Update accompanying the
diskette. If, under specific instruction from i-STAT, different versions are to be downloaded,
highlight the menu item you are to change using the UP/DOWN arrow keys and use the LEFT/
RIGHT arrow keys to set the proper version.

Note: If the software upgrade is only a CLEW, select “None” for application.
3 Highlight Download Selection and press the ENTER key.

4 Follow the instructions on the computer screen. Do not move the analyzer while download
is in progress. Do not press the DIS key. When download is complete, run the Electronic
Simulator in the Analyzer.

Note: On the handheld status page, the Application name is displayed on the line labeled Ver:
and the CLEW is displayed on the line labeled CLEW.

5 After the update of all handheld analyzers is complete, the function to restore the Customization
Profile can be used to re-enable on-line customization if desired. Be sure to select the new
CLEW in the profile first. Failure to do this will result in Quality Check Code 13.

Downloading to a Blood Analysis Module
Follow the steps below to download software to a Blood Analysis Module:

1 Highlight Utility Setup and press ENTER key. The window Utility Setup appears.

2 Using the UP/DOWN arrow keys, highlight Analyzer. Using the RIGHT/LEFT arrow keys, select
HP Blood Analysis Module.

3 Highlight Return to Main Menu and press the ENTER key.

4 Highlight Software and press the ENTER key. The window Select Files to Download appears.
The menu items Application and CLEW will automatically be set to the newest version.

5 Confirm the setting for Application and CLEW against the Product Update accompanying the
diskette. If, under specific instruction from i-STAT, different versions are to be downloaded,
highlight the menu item you are to change using the UP/DOWN arrow keys and use the LEFT/
RIGHT arrow keys to set the proper version.

Note: If the software upgrade is only a CLEW, select “None” for application.
6 Highlight Download Selection and press the ENTER key.

Fi Follow the instructions on the computer screen. Do not unplug the module while the down-
load is in progress.

Note: When the module is returned to a monitor, the CLEW can be viewed in the Blood Analy-
sis Setup screen.

Art: 714318-00C Rev. Date: 08/23/06 3



8 After the update of all modules is complete, the function to restore the Customization Profile
can be used to re-enable on-line customization if desired. Be sure to select the new CLEW in
the profile first.

Sending Software from handheld to handheld
To send software from one handheld analyzer to another, follow the instructions below:

1 Any updated analyzer can be used as the Sending Analyzer. Run the external Electronic Simu-
lator on the Sending Analyzer.

2 Transmit all data from the analyzer being updated (the Receiving Analyzer) to the Central Data
Station. Data stored in the handheld analyzer will be lost after an application software update.

3 With the Simulator test results showing on the display of the Sending Analyzer, press and hold
the DIS key and press the soft key for MENU. This displays the Utility Menu.

4 In the Utility Menu, select 3 - Send Software. The display will show the JAMS version and the
CLEW in this analyzer. Verify that these are the appropriate versions. The analyzer screen will
also say "Waiting to send”.

5 Set both analyzers on a flat surface and align the Infrared Light-Emitting Diode (IR LED) win-
dows so they directly face each other. (Refer to the analyzer picture on page 2-2 of the i-STAT
System Manual for the location of the IR LED.)

6 On the Receiving Analyzer, make sure the display is off. Press and hold the * key and press the
DIS key. The Sending analyzer will begin sending software to the Receiving Analyzer. The dis-
play on the Sending Analyzer will change from “Waiting to send” to “Sending...”, and a count-
down bar will be displayed.

Do not move the analyzers while the software is being sent.

7 When the display of the Sending Analyzer changes back to the Electronic Simulator result, the
sending of software is complete. Do not press the DIS key. Run the Electronic Simulator on
the Receiving Analyzer.

8 To update software in another analyzer, repeat these instructions from Step 2.
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TROUBLESHOOTING

Error message relating to the IR Link

If you are using any other IBM PC compatible computer, another application relating to the may be
monopolizing the COM port. Close all other open applications. Ensure the utility is set to use the proper
COM port in the Utility Setup option from the main menu. If the setting is proper, quit the Utility, turn off the
computer, unplug and replug the IR Link, restart the computer, and try the download again.

UPDATE .cfg not found
Ensure you run A:TRANSFER from an i-STAT software diskette. Ensure you run JAMMIT from C:\BINS>

Block count stops incrementing

If the block count on the status line of the computer screen stops incrementing for more than 10 seconds
during a download, press the Esc key to abort the download. If updating an handheld analyzer, take it out
of the IR Link, remove and replace the batteries to reset. If updating a Blood Analysis Module, unplug the
cable and plug it in again.

This can happen if you try to run JAMMIT under Microsoft Windows (Windows 3.1 or 95/98 platform). You
must exit Windows and run the program in the DOS mode. Try the download again.

Nothing happens OR Handheld displays results or error message when *DIS is pressed as
prompted

Remove and replace the batteries to reset the handheld. Ensure the handheld display is off. Place the
handheld back in the cradle, ensure it is properly seated. Press and hold the * key for 2 seconds, then press
the DIS key while keeping the * key pressed.

LEDs on the module are OFF

Possibly the cable or the COM port is defective. Try another cable and/or configure another port to “HP
Blood Analysis Module” and try again.

Quality Check Code 13 - Invalid Expired CLEW after on-line customization is restored
If this quality check code occurs after successfully downloading new software and restoring on-line

customization, the CLEW has not been updated to the new version in the Customization Profile. Refer to i-
STAT Technical Bulletin “Instructions for the Analyzer Customization Profile Utility.

i-STAT is a registered trademark of Abbott Laboratories.
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i-STAT® System Manual Update

As of October 2006, the current i-STAT® System Manual has been updated. Please ADD and DELETE the sheets as listed below.
Once the updales have been completed these instructions may be discarded. If you have any questions about these instructions,
please contact your i-STAT support provider.

A B ADD SHEET <« D DESTROY SHEET
Item Arth
AP lonized Calcium Information Sheet 714179-00G
<D lonized Calcium Information Sheet 714179-00F
AP i-STAT System Manual: Introduction to the
Cartridge and Test Information Section 714258-00K
<D i-STAT System Manual: Intreduction to the -
Cartridge and Test Information Section ' 714258-00J
AP i-STAT System Manual Section 12: Quality Control 715014-00E
<D i-STAT System Manual Section 12: Quality Control 715014-00D
AP i-STAT System Manual Section 13: Calibration Verification 715015-00F
<D i-STAT System Manual Section 13: Calibration Verification 715015-00E
AP i-STAT System Manual Section 18: Central Data Station 5 715021-00C
4D i-STAT System Manual Section 18: Central Data Station 5 : _ 715021-00B
<D Technical Bulletin: October 2004 Update to the i-STAT CDS Version 5 - : 7161 34-00A
<D Technical Bulletin: April 2005 Update to the i-STAT CDS Version 5 : 716244-00A
<D Technical Bulletin: October 2005 Update to the i-STAT CDS Version 5 - 716657-00A
END

© 2006 Abbott Point of Care Inc., East Windsor, NJ 08520
i-STAT is a registered trademark of Abboit Laboratories.

Abbott
Point of Care
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IONIZED CALCIUM/ICA

lonized calcium is measured by ion-selective electrode potentiometry. In the calculation of results for ionized
calcium concentration is related to potential through the Nernst equation. Results are measured at 37°C.

See below for information on factors affecting results. Certain substances, such as drugs, may affect analyte
levels in vivo.

If results appear inconsistent with the clinical assessment, the patient sample should be retested using
another cartridge.

Intended Use

The test for ionized calcium, as part of the i-STAT System, is intended for use in the in vitro quantification
of ionized calcium in arterial, venous, or capillary whole blood.

Contents

Each i-STAT cartridge contains one reference electrode (when potentiometric sensors are included in the
cartridge configuration), sensors for the measurement of specific analytes, and a buffered aqueous calibrant
solution that contains known concentrations of analytes and preservatives. For cartridges that contain a
sensor for the measurement of ionized calcium, a list of reactive ingredients is indicated below:

Reactive Ingredient

Calcium (Ca®)

Metrological Traceability

The i-STAT System test for ionized calcium measures ionized calcium (i.e. free calcium ion) amount-of-
substance concentration in the plasma fraction of arterial, venous, or capillary whole blood (dimension
mmol L) for in vitro diagnostic use. lonized calcium values assigned to i-STAT’s controls and calibration
verification materials are traceable to the U.S. National Institute of Standards and Technology (NIST)
standard reference material SRM956. i-STAT System controls and calibration verification materials are
validated for use only with the i-STAT System and assigned values may not be commutable with other
methods. Further information regarding metrological traceability is available from Abbott Point Care Inc..

Expected Values

Reportable Reference
Test/Abbreviation Units* Range Range?
lonized Calcium/iCa  mmol/L 0.25-2.50 1.12-1.32
mg/dL 1.0-10.0 45-53

*The i-STAT System can be configured with the preferred units.

Abbott
Point of Care
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To convert a result from mmol/L to mg/dL, multiply the mmol/L value by 4. To convert mmol/L to mEg/L
multiply the mmol/L value by 2.

The reference range programmed into the analyzer and shown above is intended to be used as a guide
for the interpretation of results. Since reference ranges may vary with demographic factors such as
age, gender and heritage, it is recommended that reference ranges be determined for the population
being tested.

Clinical Significance

Although most of the calcium in blood is bound to protein or complexed to smaller anionic species, the
biologically active fraction of calcium is free ionized calcium. Through its role in a number of enzymatic
reactions and in membrane transport mechanisms, ionized calcium is vitally important in blood coagulation,
nerve conduction, neuromuscular transmission and in muscle contraction. Increased ionized calcium
(hypercalcemia) may result in coma. Other symptoms reflect neuromuscular disturbances, such as
hyperreflexia and/or neurologic abnormalities such as neurasthenia, depression or psychosis. Decreased
ionized calcium (hypocalcemia) often results in cramps (tetany), reduced cardiac stroke work and depressed
left ventricular function. Prolonged hypocalcemia may result in bone demineralization (osteoporosis) which
can lead to spontaneous fractures. Measurements of ionized calcium have proven of value under the
following clinical conditions: transfusion of citrated blood, liver transplantation, open heart surgery, neonatal
hypocalcemia, renal disease, hyperparathyroidism, malignancy, hypertension and pancreatitis.

Performance Characteristics

The typical performance data summarized below was collected in health care facilities by health care
professionals trained in the use of the i-STAT System and comparative methods.

Precision data were collected in multiple sites as follows: Duplicates of each control fluid were tested in the
morning and in the afternoon on five days for a total of 20 replicates. The averaged statistics are presented
below.

Method comparison data were collected using CLSI guideline EP9-A®. Venous blood samples were
collected in lithium heparin Vacutainer® tubes and analyzed in duplicate on the i-STAT System and on the
comparative methods within 10 minutes of each other.

Deming regression analysis* was performed on the first replicate of each sample. In the method comparison
table, n is the number of specimens in the data set, Sxx and Syy refer to estimates of imprecision based
on the duplicates of the comparative and the i-STAT methods respectively, Sy.x is the standard error of the
estimate, and r is the correlation coefficient.*

Method comparisons will vary from site to site due to differences in sample handling, comparative method
calibration and other site specific variables.

Interference studies were based on CLSI guideline EP7-P.°

 The usual warning relating to the use of regression analysis is summarized here as a reminder: For any analyte, “if the data is collected over

a narrow range, the estimate of the regression parameters are relatively imprecise and may be biased. Therefore, predictions made from these

estimates may be invalid”.3 The correlation coefficient, r, can be used as a guide to assess the adequacy of the comparative method range in
overcoming this problem. As a guide, the range of data can be considered adequate if r>0.975.

Precision Data (mmol/L)

Agueous Control Mean SD %CV
Level 1 1.60 0.017 1.1
Level 3 0.84 0.012 1.4

iCa-2 Art: 714179-00G Rev. Date: 08/14/06



Method Comparison (mmol/L)
Radiometer ICA1 Nova STAT Profile

n 47 57

Sxx 0.009 0.017
Syy 0.017 0.017
Slope 0.925 0.960
Int’t 01713 0.062
Sy.x 0.035 0.029
Xmin 0.46 0.53
Xmax 2.05 2.05
r 0.982 0.982

Factors Affecting Results*

Venous stasis (prolonged tourniquet application) and forearm exercise may increase ionized calcium due to
a decrease in pH caused by localized production of lactic acid®. Exposing the sample to air will cause an
increase in pH due to the loss of CO, which will decrease ionized calcium.

Heparin binds calcium. Each unit of heparin added per mL of blood will decrease ionized calcium by 0.01
mmol/L.® Therefore, the correct ratio of heparin anticoagulant to blood must be achieved during sample
collection. Intravenous injection of 10,000 units of heparin has been shown in adults to cause a significant
decrease of ionized calcium of about 0.03 mmol/L.® Use only unheparinized sample transfer devices when
using i-STAT’s aqueous control and calibration verification materials.

Hemodilution of the plasma by more than 20% associated with priming cardiopulmonary bypass pumps,
plasma volume expansion or other fluid administration therapies using certain solutions may cause clinically
significant error on sodium, chloride, ionized calcium and pH results. These errors are associated with
solutions that do not match the ionic characteristics of plasma. To avoid these errors when hemodiluting by
more than 20%, use physiologically balanced multi-electrolyte solutions containing low-mobility anions (e.g.
gluconate) such as Normosol®-R (Abbott Laboratories), Plasma-Lyte®-A (Baxter Healthcare Corporation),
and Isolyte®-S (B Braun Medical) rather than solutions such as normal saline or Ringer’s Lactate.

Interferent Effect

B-hydroxybutyrate 20 mmol/L B-hydroxybutyrate will decrease ionized calcium results by
0.1 mmol/L.

Lactate 20 mmol/L lactate will decrease ionized calcium results by 0.05 mmol/L.

Magnesium 1.0 mmol/L magnesium above normal will increase ionized calcium results by 0.04
mmol/L.

Salicylate 4.34 mmol/L salicylate will decrease ionized calcium results by 0.1 mmol/L.

“Itis possible that other interfering substances may be encountered. These results are representative and your results may differ somewhat due to
test-to-test variation. The degree of interference at concentrations other than those listed might not be predictable.
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CARTRIDGE AND TEST
INFORMATION

i-STAT sensors are available in a variety of panel configurations. Sensors are contained in cartridges with microfluidic
components and, in some cartridges, calibration solution. i-STAT cartridges are used with the i-STAT Portable Clinical
Analyzer, the i-STAT 1 Analyzer* and the Philips Medical Systems Blood Analysis Module** for the simultaneous
quantitative determination of specific analytes and coagulation parameters in whole blood.

CARTRIDGE SPECIFICATIONS

Shelf Life:

Preparation for Use:

Sample Type:

Sample Volume:

Test Timing:

Refrigerated at 2 to 8°C (35 to 46°F) until expiration date.

Room temperature at 18 to 30°C (64 to 86°F) for two weeks.

Individual cartridges may be used after standing five minutes at room temperature. An
entire box of cartridges should stand at room temperature for one hour.

All cartridges should be used immediately after opening pouch. If the pouch has been
punctured, the cartridge should not be used.

Fresh whole blood from arterial, venous, or skin punctures

(Note: Skin puncture is NOT a recommended sample type for ACT, cTnl, CK-MB, or BNP
testing.)

cTnl and CK-MB cartridges require the use of heparinized whole blood or plasma, or non-
heparinized whole blood tested within one minute of patient draw.

BNP cartridges require the use of EDTA whole blood or plasma samples.
17uL, 20uL, 40uL, 65uL, or 95uL depending on cartridge type.

Immediately after collection
e  Samples for the measurement of ACT, PT/INR and Lactate

Within 3 minutes after collection
* Samples collected in capillary tubes, both with and without anticoagulant

e Samples collected in evacuated or non-evacuated tubes and syringes without
anticoagulant
Within 10 minutes after collection

* Samples collected with anticoagulant for the measurement of pH, PCO,, PO,
and iCa. Maintain anaerobic conditions. Remix before filling cartridge.

Within 30 minutes after collection

e Sodium, potassium, chloride, glucose, BUN/urea, creatinine, hematocrit,
troponin I, CK-MB, and BNP. Remix thoroughly before testing.

Abbott
Point of Care
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Analysis Time:

* The cTnl, CK-MB, and BNP cartridges can only be used with the i-STAT 1 analyzer bearing
the ﬁ symbol. The CHEM8+ cartridge can only be used with the i-STAT 1 analyzer,

** Blood Analysis Module supports neither the PT/INR, the CHEMB8+, the ¢Tnl, the CK-MB
nor the BNP cartridge.

*  ACT cartridge: to detection of end point - up to 1000 seconds (16.7 min.)

*  PT/INR cartridge: to detection of end point — up to 300 seconds (5 min.)

e cTnl and BNP cartridges: 600 seconds (10 min.)

e CK-MB cartridge: 300 seconds (5 min.)

e Other cartridges: typically 130 to 200 seconds

Cartridges
which
e

Syringes

::bes b

irectly from

| Skin Puncture

» Without anticoagulant
* With balanced

heparin anticoagulant
(syringe must be filled
to labeled capacity)

* Without anticoagulant
= With sodium or lithium

heparin anticoagulant
(tubes must be filled
to capacity)

e Without
anticoagulant

» With balanced
heparin
anticoagulant

e Not recommended

 which

Cartridges

Without anticoagulant
ONLY

Syringes must be
plastic

Without
anticoagulant, clot
activators, or serum
separators ONLY

Tubes must be plastic

Devices used to
transfer sample to
cartridge must be
plastic

e Not recommended

¢ Not recommended

Without anticoagulant
ONLY

Syringes must be
plastic

Without
anticoagulant, clot
activators, or serum
separators ONLY

Tubes must be plastic

Devices used to
transfer sample to
cartridge must be
plastic

* Not recommended

* Recommended

With Sodium or
lithium heparin
anticoagulant.

Without anticoagulant
if tested within one
minute of patient
draw.

With Sodium or
lithium heparin
anticoagulant.

Without anticoagulant
if tested within one
minute of patient
draw.

Samples should not
be used unless the
blood collection tube
is filled at least half
full.

¢ Not recommended

* Not recommended

Art: 714258-00K
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With EDTA
anticoagulant.

Syringes must be
plastic.

» With EDTA
anticoagulant.

* Tubes must be
plastic.

» Samples should not
be used unless the
blood collection tube
is filled at least half
full.

* Not recommended

| All other
 cartridges

Without anticoagulant

With lithium, sodium,
or balanced heparin
anticoagulant

= Without anticoagulant
e With lithium or sodium

heparin anticoagulant

¢ Without
anticoagulant

» With balanced
heparin
anticoagulant

¢ With sodium or
lithium heparin
if labeled for the
measurement of
electrolytes

* While a sample
can be transferred
directly from a
skin puncture
to a cartridge, a
capillary tube is
preferred.

Note Regarding System

The i-STAT System automatically runs a comprehensive set of quality checks of analyzer

Reliability and cartridge performance each time a sample is tested. This internal quality system will
suppress results if the analyzer or cartridge does not meet certain internal specifications
(see Quality Control section in System Manual for detailed information). To minimize the
probability of delivering a result with medically significant error the internal specifications
are very stringent. It is typical for the system to suppress a very small percentage of
results in normal operation given the stringency of these specifications. If however the
analyzer or cartridges have been compromised, results may be persistently suppressed,
and one or the other must be replaced to restore normal operating conditions. Where
unavailability of results while awaiting replacement of analyzers or cartridges is
unacceptable, i-STAT recommends maintaining both a backup i-STAT System
analyzer and cartridges from an alternate lot number.
EXPECTED VALUES
Measured:
REPORTABLE REFERENCE
TEST UNITS RANGE RANGE
(arterial) (venous)
Sodium/Na mmol/L (mEg/L) 100 - 180 138 -146 138 - 146
Potassium/K mmol/L (mEg/L) 2.0-9.0 35-49 35-4.9
Chloride/Cl mmol/L (mEg/L) 65 -140 98 - 109 98 - 109
Glucose/Glu mmol/L 1.1-38.9 3.9-58 39-58
mg/dL 20-700 70-105 70-105
a/L 0.20-7.00 0.70 - 1.05 0.70-1.05
Lactate/Lac mmol/L 0.30 —20.00 0.36-1.25 0.90-1.70
mg/dL 2.7-180.2 32-11.3 8.1-153
Creatinine/Crea mg/dL 0.2 -20.0 0.6-1.3 0.6-13
prmol/L 18 -1768 58 =115 =-B583-115
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Measured: (cont.)

REPORTABLE REFERENCE
TEST UNITS RANGE RANGE
(arterial) (venous)

pH 6.5-8.2 7.35-7.45 7.31 -7.41
PCO2 mmHg 5—130 35-45 41 -51

kPa 0.67 - 17.33 4.67 - 6.00 5.47 - 6.80
TCO»2 mmol/L (mEg/L) 5-50 23-27 24-29
{on the CHEMB8+ cartridge only)
PO> mmHg 5 - 800 80-105

kPa 0.7-106.6 10.7 - 14.0
lonized Calcium/iCa mmol/L 0.25-2.50 1.12-1.32 1.12-1.32

mg/dL 1.0-10.0 45-53 45-53
Urea Nitrogen/BUN mg/dL 3-140 8-26 8-26
Urea mmol/L HE=st) 29-94 2994

mg/dL 6 - 300 17 - 56 17 — 56
Hematocrit/Hct %PCV 10-75 38 - 51 38 - 51

Fraction 0.10-0.75 0.38 - 0.51 0.38 - 0.51
Celite Activated seconds 50 - 1000 74 — 125 (Prewrm) 74 — 125 (Prewrm)

Clotting Time /
CeliteACT

84 - 139 (Nonwrm)

The range from 80 - 1000 seconds has been verified through method comparison studies.

84 — 139 (Nonwrm)}

Kaolin Activated

seconds

50 - 1000

74 — 137 (Prewrm)

74 — 137 (Prewrm)

Clotting Time / 82 — 152 (Nonwrm) 82 - 152 (Nonwrm)

KaolinpACT : :

The range from 77 - 1000 seconds has been verified through method comparison studies.

Prothrombin Time / PT  INR 0.9-8.0

Performance characteristics have not been established for INRs above 6.0.

Troponin I / cTnl ng/ml (ug/L) 0.00 - 50.00 0.00-0.03"
0.00 — 0.08™

Performance characteristics have not been established for cTnl values above 35.00 ng/mL..

* Represents the 0 to 97.5% range of results.

** Represents the 0 to 99% range of results.

Creatine Kinase MB/  ng/mL (ug/L) 0.0-150.0 0.0-3.5™

CK-MB : : !

***Represents the 0 to 95% range of results.

B-Type Natriuretic pg/mL (ng/L) 15 - 5000

Peptide / BNP

# Represents the 0 to 95% range of results.

<15~ 504
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Calculated:

REPORTABLE REFERENCE
TEST UNITS RANGE RANGE
(arterial) (venous)

Hemoglobin/Hb g/dL 3.4-255 12-17 12-17

g/L 34 - 255 120-170 120- 170

mmol/L 2.1-158 7—11 7-11
TCO2 mmol/L (mEg/L) 5-50 23 =27 24 -29
(on all cartridges but the CHEM84+)
HCO3 mmol/L (mEg/L) 1.0-85.0 22-26 23-28
BE mmol/L (mEg/L) (-30) — (+30) (2)= (+3) (-2) - (+3)
Anion Gap/AnGap mmol/L (mEg/L) (-10) - (+99) 10-20 10-20
sO2 % 0-100 95 -98

Art: 714258-00K
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CARTRIDGE CONFIGURATIONS AND SAMPLE VOLUME

-STAT 8" e

Sodium (Na)
Potassium (K)
Chloride (Cl)

pH

PCO»

Urea Nitrogen (BUN)/Urea
Glucose (Glu)
Hematocrit (Hct)
TCO*

HCO5*

BE~

Anion Gap* (Angap)
Hemoglobin* (Hb)

[STAT &
Sodium (Na)

Potassium (K)

Chiloride (Cl}

Urea Nitrogen (BUN)/Urea
Glucose (Glu)

Hematocrit (Hct)

Hemoglobin* (Hb)

FSTAT =" s
Sodium (Na)

Potassium (K)

Glucose (Glu)
Hematocrit (Hct)

Hemoglobin* (Hb)

-STAT %" e
Sodium (Na)

Potassium (K)
Hematocrit (Hct)

Hemoglobin* (Hb)

FSTAT 6

Glucose (Glu)

I-S | 'A| CREA (65uL)

Creatinine (Crea)

CTl Info. 6

FSTAT 7" e

Sodium (Na)
Potassium (K)
lonized Calcium (iCa)
Hematocrit (Het)
pH

P002

PO

TCOy~

HCOz*

BE~

502*
Hemoglobin™ (Hb)

-STAT 6" o
Sodium (Na)
Potassium (K)
Hematocrit (Het)
pH

PCO,

PO2

TCOQ*

HCOg*

BE~

502*
Hemoglobin® (Hb)

FSTAT %" e
pH

PCO,
PO,
TCOQ*
HCOZ*
BE-«
502*

FSTAT °4" v
pH

Lactate
TCO"
HCO3"
BE=
502*

*Calculated

Art: 714258-00J

FSTAT 8" ==
Sodium (Na)

Potassium (K)

lonized Calcium (iCa)
Glucose (Glu)
Hematocrit (Hct)

pH

PCOo

PO5

TCOo*

HCOgz*

BE-
502
Hemoglobin® (Hb)

j_S’m Celite ACT (s0uL)

Celite® ACT

FSTAT *ACT wou

Kaolin ACT

l-S'm PT/INR  (2o0u)

Prothrombin Time

IFSTAT <Tni 07w

Troponin |

I-STAT C€K-MB v

Creatine Kinase MB

FSTAT BnP

B-type Natriuretic Peptide

j-S'rAT‘ CHEM8+ (95uL)

Sodium (Na)
Potassium (K)
Chloride (Cl)

Urea Nitrogen (BUN)/Urea
Glucose (Glu)
Creatinine (Crea)
lonized Calcium (iCa)
TCOy

Hematocrit (Het)
Anion Gap* (Angap)
Hemoglobin* (Hb)

*

Celite is a registered trademark
of Celite Corporation, Santa
Barbara, CA, for its diatomaceous
earth products.
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Overview

Customization

Data Retention

QUALITY CONTROL

This section describes the steps to be taken to verify the performance of the
analyzer and cartridges. The rationale for the i-STAT catridge and analyzer
quality regimen is described in the Theory section of this manual.

The quality control behavior of the analyzer can be customized via the
Central Data Station to:

* turn the external Electronic Simulator reminder on or off.

* prompt the operator to use the external Electronic Simulator at
scheduled intervals.

¢ turn the internal Electronic Simulator on or off , and select the
simulator test cycle intervals.

» disable further cartridge testing when the internal Electronic
Simulator test fails.

See the Customization section for default values.

Quality control data is transmitted to the Central Data Station. If a Central
Data Station is not being used, the charts at the end if this section can be
used to record liquid and electronic control results.

QUALITY CONTROL FOR i-STAT CARTRIDGES AND THE ANALYZER'S CARTRIDGE TEST CYCLE

Verify Newly
Received Cartridges

Verify Performance
of Analyzers Daily

Check Refrigerator
Storage Daily

Check Room
Temperature

Storage Daily

Art: 715014-00E

1. Verify that the transit temperatures were satisfactory using the four-
window temperature indicator strip included in the shipping container.

2. Trom each lot in each shipment of cartridges, analyze multiple levels of
i-STAT controls (and Meter Trax™ or RNA® Medical controls if testing for
hematocrit) using any verified analyzer.

Verify the performance of each analyzer on site using the Electronic
Simulator (external or internal) once a day on the days the analyzers are in

use. Note that regulatory or accreditation requirements may dictate more
frequent intervals.

Verify that the cartridges stored in the refrigerator are within the expiration
date printed on the boxes.

Verify that the storage refrigerator did not exceed the temperature limits of 2
to 8 °C (35 to 46 °F). If storage conditions are in doubt, use controls to verify
that the cartridges are performing properly. This is especially important if
freezing conditions are suspected at the back of the refrigerator.

Verify that the cartridges stored at room temperature are within the
expiration date and that the cartridges have been out of the refrigerator less
than two weeks. If the temperature at which the cartridges are stored is in
doubt, use controls to verify that the cartridges are performing properly.

Rev. Date: 08/23/06 12-1



Check Thermal i-STAT analyzers contain a thermal control subsystem consisting of two thermal

Control System probes with thermistors and heating contact wires. When measurements are

Twice a Year performed at a controlled temperature, the thermal probes in the analyzer
contact the metalized area under the chips in the cartridge and maintain the
temperature of the sensors and the tfluids that come into contact with these
sensors at the required temperature + 0.15°C.

A quality check is performed on the thermal probes each time the external
Electronic Simulator is used. To complete this check, the surface temperature
of the external Electronic Simulator must not fluctuate. If this condition is not
met, the thermal probe check is not completed. Therefore, i-STAT recommends

that the thermal probe check be verified twice a year.

Check the The analyzer uses ambient temperature measurements to ensure that the
Analyzer Ambient temperature is within the operating range and in the extrapolation of
Temperature ambient temperature measurement results for ionized calcium, pH and

Reading Once a Year PCO5 to 37 °C results.

CONTROLS FOR BLOOD GAS/ELECTROLYTE/METABOLITE CARTRIDGES

Control Solutions Aqueous assayed control fluids are available for verifying the integrity of
newly received cartridges. i-STAT Level 1, 2 and 3 Control are formulated
at three clinically relevant levels with known pH and with known
concentrations of:

Sodium PCOy Glucose
Potassium PO,y Lactate
Chloride BUN/Urea
lonized Calcium Creatinine

Each level of control is packaged in a box of 10 ampules with a sheet with
target values and acceptable ranges. Control solutions are contained in 1.7
mL glass ampules.

The control solutions do not contain human serum or serum products, but
do contain buffers and preservatives.

Reactive Ingredients

Na (mmol/L) 108 127 141 169 187
K (mmol/L) 2:3 3.1 4.0 6.8 8.5
Cl (mmol/L) 71 85 100 122 133
Glu (mmol/L) 1.8 2.5 7.3 17 35
Urea (mmol/L) 44.6 18 -+ Z:7 1.8
iCa (mmol/L) 2.5 1.6 13 0.8 0.2
Lac (mmol/L) 19.5 8.4 2.3 1 0.6
Crea (pmol/L) 1486 386 155 46 17
POy (mmHg) 43 61 100 140 400
PCO, (mmHg) 95 66 30 22 18
H* (pt) 6.81 7.15 7.41 7.60 7.95
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Storage

Best Results

Ampule Use

Before Use

Procedure

Transfer with
Capillary Tube

Rev. Date: 08/23/06

Refrigerated storage at 2 to 8 °C (35 to 46 °F) should be maintained until the
printed expiration date on the box and ampule labels.

Control solutions may also be stored at room temperature for up to 5 days
(18 to 30 °C or 64 to 86 °F). Prolonged storage at temperatures greater than
30 °C (86 °F) may cause changes in the values of some analytes. Do not use
beyond the expiration date on the box and ampule labels.

For best results, ampules, cartridges and analyzer should be at the same
temperature.

When using cartridges that contain sensors for pH, PCOy, PO, and ionized
calcium, a separate ampule must be used for each cartridge being tested.

Do not use the solution left in a syringe, ampule or capillary tube for
additional testing of cartridges that contain sensors for ionized calcium, pH,
PCOy, or PO,. However, cartridges without these sensors may be tested with
remaining fluids if within 10 minutes of opening the ampule.

i-STAT control solutions require different temperature stabilization times
depending on whether or not oxygen is to be measured. If oxygen is to be
measured, equilibrate the ampule for 4 hours. If not, equilibrate the ampule
for approximately 30 minutes at room (ambient) temperature.

STEP ACTION

I Immedlal fo e use, shake the ampule Vigorouslyor 5to 10
seconds to equilibrate the liquid and gas phases.

To shake, hold the ampule at the tip and bottom with forefinger
and thumb to minimize increasing the temperature of the
solution. If necessary, tap the tip of the ampule to send solution
back into the bottom section of the ampule.

2 Protect fingers with gauze, tissue or glove, or use an ampule
breaker to snap off the tip of the ampule at the neck.

3 Immediately transfer the solution from the ampule into a
capillary tube or syringe, and then immediately transfer the
solution into a cartridge.

4 Immediately seal the cartridge and insert it into an analyzer — it is
important not to expose the solution to room air since this
will alter the results. Note: Since aqueous based solutions
such as controls lack the buffering capabilities of whole blood,
the transfer process from ampule to cartridge must be more
expedient than with a patient sample.

Plain capillary tubes are recommended to transfer an aqueous control from
the ampule to the cartridge. When using a capillary tube (fresh capillary
tubes with sufficient fill capacity are recommended), fill from the bottom
of the ampule to avoid drawing air into the capillary tube. Avoid drawing
solution from the surface by placing a finger over the far end of the tube as
it is inserted into the ampule. Once the open end of the tube rests at the
bottom of the ampule, uncover the other end to allow filling by capillary
action.

Art: 715014-00E
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Transfer with
Syringe

Target Values

Ranges

Correction of PO5 at
Extreme Altitude

Plain syringes are recommended to transfer an aqueous control from
the ampule to the cartridge. When using a syringe (fresh 1cc or 3cc
sterile syringe with 16 - 20 gauge needles are recommended), slowly draw
approximately 1mL of solution from the bottom of the ampule.

If air is trapped between the leading edge of the solution and the plunger, do
not invert the syringe to expel it; this will not affect solution near the tip of
the syringe.

If air bubbles are continually drawn into the syringe, or if a bubble is trapped
near the tip of the syringe, discard the ampule and syringe and use a fresh
ampule and syringe.

Expel one or two drops from the syringe before filling the cartridge.

Target values (determined by testing multiple ampules of each level using
multiple lots of cartridges and i-STAT analyzers that have passed the
Electronic Simulator test) are printed on a value assignment sheet included
with each box of control ampules.

Always be sure that the lot number printed on the insert matches the lot
number on the label of the ampule in use, and that the software revision
above the target value table matches the software revision in the analyzer.

The ranges displayed represent the maximum deviation expected when
controls and cartridges are performing properly.

Should results outside the ranges be obtained, refer to the Troubleshooting
section that follows the Procedure for Testing Controls.

Target Values are specific to the i-STAT System. Results obtained from these
aqueous controls with other methods may differ due to sample matrix
effects.

The partial pressure of oxygen in a solution will change as it equilibrates
to the surrounding ambient pressure. The rate of change is faster in
aqueous solutions than in whole blood due to the absence of red blood cells
containing hemoglobin which binds oxygen molecules. This is of practical
significance when testing aqueous solutions on blood gas analyzers as there
will be a detectable shift in the partial pressure of oxygen in the sample as it
equilibrates to the pressure in the flowpath of the analyzer.

The ranges for i-STAT aqueous control solutions are established for the degree
of oxygen equilibration which occurs in the cartridges at or near sea level.
POy results for aqueous solutions, including i-STAT controls and Calibration
Verification Set and proficiency (external quality control) samples, can be
corrected for higher altitude environments using the following equations.
Observed POo values should be corrected before comparing them to the
values in the value assignment sheet included with each box of i-STAT
controls.

Equations:

For PO values below 150 mmHg:
PO corrected = POy observed + (0.067 x (760 — BP))
Where BP is the barometric pressure reading from the
Analyzer Status screen.
(Approximate change: For every decrease of 15 mmHg in pressure
from 760 mmHg, add 1 mmHg to observed value.)
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For PO, value above 150 mmHg:
PO, corrected = PO5 observed + (0.029 x (760 — BP))
Where BP is the barometric pressure reading from the
Analyzer Status screen.
(Approximate change: For every decrease of 35 mmHg in pressure
from 760 mmHg, add 1 mmHg to observed value.)

RNA® MEDICAL HEMATOCRIT CONTROL

Intended Use

Product Description

Active Ingredients

Storage

Directions For Use

Rev. Date: 08/23/06

RNA Medical Hematocrit Control is a quality control material used for
verifying the performance of hematocrit sensors in i-STAT cartridges.

Hematocrit controls are provided in three (3) levels for monitoring cartridge
performance at different points within the clinical range. The controls
are packaged in sealed glass ampules, each containing 1.7 mL of solution.
Ampules are packaged ten (10) per box.

This product is a buffered aqueous solution containing electrolytes and non-
conductive ingredients. This control contains no red blood cells, and no
human or biological material.

RNA Medical Hematocrit Control is stable until the expiration date stated on
the ampule when stored at temperatures of 2-25 °C. Do not freeze or expose
ampules to temperatures greater than 30 °C.

If stored refrigerated, the control material should be equilibrated to room
temperature for at least four (4) hours prior to testing.

The product may turn slightly yellow in color over its shelf life if stored at
room temperature. This coloration is normal and does not affect product
performance.

For each lot of i-STAT cartridges received, use a representational number of
cartridges to analyze multiple levels of RNA Medical Hematocrit controls.

1. Gently invert the ampule to mix the solution. Tap the ampule to
restore the liquid to the bottom of the ampule.

2. Open the ampule by snapping off the tip at the neck. Use gauze, tissue,
gloves, or an appropriate ampule opener to protect fingers from cuts.

3. Fill and seal a cartridge and insert immediately into the analyzer.

4. Compare the i-STAT System Hematocrit result to the package insert
value. If the result is within the expected range, use the cartridges as
needed.

i. If the results are outside of the expected range, consult page 12-9 of
this section for troubleshooting recommendations.

ii. Note: this product is a buffered aqueous solution containing
electrolytes and non-conductive ingredients. The only value
assigned to this fluid is for hematocrit. All other cartridge analyte
results obtained with this control material should be ignored.

5. If available, transmit results to the Central Data Station.

Art: 715014-00E
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METER TRAX™ CONTROLS FOR HEMATOCRIT SENSOR

Meter Trax™ Whole Blood Reference Control for Glucose, Hemoglobin and
Hematocrit (Meter Trax is a trademark of Hematronix, Inc., now BIO-RAD) is
recommended as a control solution for the hematocrit sensor. Meter Trax is
available in three levels: Low, Mid and High in boxes of one level (6x2mlL)
or boxes of three levels (6x2mL or 3x2mL).

CONTROLS FOR ACT CARTRIDGES

Intended Use

Contents

Storage

Warnings and
Precautions

The i-STAT® ACT Control Level 1 and ACT Control Level 2 are intended
for use to verify the integrity of newly received i-STAT ACT cartridges.
The controls produce clotting times expected for moderate and high level
heparinization to indicate that the cartridges are functioning properly.

Each level of control is packaged as a box of 5 vials of lyophilized human
plasma and 5 vials of 9.5 £ 1.5 mmol/L calcium chloride diluent.

i-STAT ACT controls, Levels 1 and 2, are contained in 6-mL vials. Separate
6-mL vials contain 1-3 mL of calcium chloride solution for reconstitution.
Refrigerated storage at 2 to 8°C (35 to 46°F) should be maintained until the
printed expiration date on the box and vial labels. Do not use beyond the
expiration date on the box and vial labels.

Control solutions may also be stored at room temperature for up to 4
hours (18 to 30°C or 64 to 86°F). If left out longer than 4 hours at room
temperature, they should be discarded.

Handle this product using the same safety precautions used when handling
any potentially infectious material. The human plasma used in the
preparation of this product has been tested by FDA approved test methods
and found negative/non-reactive for HIV-1, HIV-2, HBsAg, and HCV.
However, no known test method can offer complete assurance that products
derived from human blood will not transmit infectious disease.

Dispose of this product as biohazardous waste according to all local, state,
and national regulations.
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Directions for Use

Control Target

Prior to testing, vials containing the lyophilized plasma and CaCl,
reconstituting fluid should stand at room temperature (18 - 30°C or 64 -
86°F) for a minimum of 45 minutes. For best results, vials, cartridges, and
analyzers should be at the same temperature.

Reconstitute only one level of control plasma at a time. CONTROL

SOLUTIONS MUST BE USED IMMEDIATELY (less than 30 seconds) AFTER
COMPLETING THE RECONSTITUTION AND MIXING STEPS.

ACTION

1 After 45 minute room temperature equilibration, remove the cap
and stopper from one lyophilized human plasma control vial and
remove the cap from one vial of calcium chloride reconstituting
fluid.

2 Pour the entire contents of the calcium chloride vial into the
lyophilized human plasma control vial. Place the stopper back
in the reconstituted control vial, sealing the vial appropriately so
that the contents do not leak or spill out.

3 Allow the vial to sit at room temperature for 1 minute.

Mix the contents of the vial by swirling gently for 1
minute, then inverting slowly for 30 seconds.
Note: To minimize foaming of the control sample, avoid vigorous
or rapid mixing motion. Visually inspect the control vial to
ensure that the sample is fully reconstituted. If not, discard the
reconstituted fluid and start over with fresh vials.

5 Using a plastic transfer pipette, plastic syringe, or plastic capillary
tube with no anticoagulant, immediately transfer the solution
from the vial into the ACT cartridge

6 Immediately seal the cartridge and insert it into an analyzer.
Note: Additional ACT cartridges may be tested with the remaining
fluid if used within 30 seconds of complete reconstitution of the
sample.

Target values (determined by testing multiple vials of each level using

Values and Expected multiple lots of i-STAT cartridges with analyzers that have passed the

Ranges

Electronic Simulator test) are printed on a value assignment sheet
included in each box of control vials. The ranges displayed represent
the maximum deviation expected when controls and cartridges
are performing properly. Should results outside the range be
obtained, refer to the Troubleshooting portion of this section of the
i-STAT System Manual (page 12-9). Always be sure that the lot number
printed on the value assignment sheet matches the lot number on the label
of the vial in use, and that the software revision above the table matches the
software revision in the analyzer (check the status page on the analyzer).

Note: Target values are specific to the i-STAT System; results obtained from
these reconstituted control plasmas may differ if used with other methods.

CONTROLS FOR PT/INR CARTRIDGES

Intended Use

Rev. Date: 08/23/06

The i-STAT® PT Control Level 1 (normal) and PT Control Level 2 (abnormal)
are used to verify the integrity of newly received PT/INR cartridges.

Art: 715014-00E
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Contents

Storage

Warnings and
Precautions

Directions for Use

Each level of control is packaged as a box of 5 vials of lyophilized human
plasma and 5 vials of calcium chloride diluent. The Level 1 control vials contain
9.5 + 1.5 mmol/L calcium chloride, while the Level 2 control vials contain

12 + 2.0 mmol/L calcium chloride.

i-STAT PT controls, Levels 1 and 2, are contained in 6-mL vials. Separate
6-mL vials contain 1-3 mL of calcium chloride solution for reconstitution.
Refrigerated storage at 2 to 8°C (35 to 46°F) should be maintained until the
printed expiration date on the box and vial labels. Do not use beyond the
expiration date on the box and vial labels.

Control solutions may also be stored at room temperature for up to 4
hours (18 to 30°C or 64 to 86°F). If left out longer than 4 hours at room
temperature, they should be discarded.

Handle this product using the same safety precautions used when handling any
potentially infectious material. The human plasma used in the preparation
of this product has been tested by FDA approved test methods and found
negative/non-reactive for HIV-1, HIV-2, HBsAg, and HCV. However, no known
test method can offer complete assurance that products derived from human
blood will not transmit infectious disease.

Dispose of this product as biohazardous waste according to all local, state, and
national regulations.

Prior to testing, vials containing the lyophilized plasma and CaCly
reconstituting fluid should stand at room temperature 18-30°C (64-86°F) for a
minimum of 45 minutes. For best results, vials, cartridges, and analyzers should
be at the same temperature.

Reconstitute only one level of control plasma at a time. CONTROL SOLUTIONS
MUST BE USED IMMEDIATELY (less than 30 seconds) AFTER COMPLETING

THE RECONSTITUTION AND MIXING STEPS.

STEP ACTION

i After 45 minute room temperature equilibration, remove the cap
and stopper from one lyophilized human plasma control vial and
remove the cap from one vial of calcium chloride reconstituting
fluid.

2 Pour the entire contents ot the calcium chloride vial into the
lyophilized human plasma control vial. Place the stopper back in
the reconstituted control vial, sealing the vial appropriately so that
the contents do not leak or spill out.

3 Allow the vial to sit at room temperature for 1 minute.

4 Mix the contents of the vial by swirling gently for 1 minute, then
inverting slowly for 30 seconds.

Note: To minimize foaming of the control sample, avoid vigorous
or rapid mixing motion. Visually inspect the control vial to ensure
that the sample is fully reconstituted. If not, discard and start over
with fresh vials.

5 Using a plastic transfer pipette, plastic syringe, or plastic capillary
tube with no anticoagulant, immediately transfer the solution from
the vial into the PT/INR cartridge.

6 Immediately seal the cartridge and insert it into an analyzer.
Note: Additional PT/INR cartridges may be tested with
the remaining fluid if used within 30 seconds of complete
reconstitution of the sample.
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Control Target
Valuves and Expected
Ranges

Target values (determined by testing multiple vials of each level using
multiple lots of i-STAT cartridges with analyzers that have passed the
Electronic Simulator test) are printed on a value assignment sheet included
in each box of control vials. The ranges displayed represent the maximum
deviation expected when controls and cartridges are performing properly.
Should results outside the range be obtained, refer to the Troubleshooting
portion of this section of the i-STAT System Manual (page 12-9). Always
be sure that the lot number printed on the value assignment sheet matches
the lot number on the label of the vial in use, and that the software revision
above the table matches the software revision in the analyzer (check the
status page on the analyzer).

Note: Target values are specific to the i-STAT System; results obtained from
these reconstituted control plasmas may differ if used with other methods.

TROUBLESHOOTING OUT-OF-RANGE RESULTS

Troubleshooting

Verify that the following conditions are met and then repeat the test:

* The correct expected values insert is being used and the correct
cartridge type and lot number listing is being used.

» [Expiration date printed on cartridge pouch and control ampule or
vial have not been exceeded.

* Room temperature expiration date for cartridge and control have not
been exceeded.

* Cartridge and control have been stored correctly.
* The control has been handled correctly: See the directions for use.
* The analyzer being used passes the Electronic Simulator test.

If the results are still out of range despite meeting the above criteria, repeat
the test using a new box of control solutions and/or cartridges. If the
results are still out of range, refer to Support Services information in the
Troubleshooting section.

INTERNAL ELECTRONIC SIMULATOR

Procedure for the
Internal Electronic
Simulator

Rev. Date: 08/23/06

The internal Electronic Simulator test cycle is automatically activated when a
cartridge is inserted after the customized interval is reached. If the analyzer
passes the simulator test, the cartridge test cycle proceeds. If not, the analyzer
displays “ELECTRONIC SIMULATOR FAIL.” If the analyzer is customized to
block testing when it fails the simulator test, the same cartridge can be
reinserted immediately after the FAIL message is displayed. If the analyzer
fails the simulator test again, see the Troubleshooting section that follows the
Procedure. If less than three minutes has elapsed, the cartridge can be inserted
into another analyzer. If the analyzer is not customized to block testing after
a failed simulator test, the internal simulator test will not repeat until the
programmed interval has elapsed.

Art: 715014-00E
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EXTERNAL ELECTRONIC SIMULATOR

Procedure for

External Electronic

Simulator on
Analyzer

ELECTRONIC
SIMULATOR

PASS

|09:44 14»\_pnc_a_aJ

MENU

If the simulator has a blue
cover over the contact pads,

Insert the simulator into the
analyzer with the "i” facing up.

Enter 1D# Below

Contacting Cartridge

Do not touch the contact pads, remove it.
LCk The simulator will activate
i, the analyzer when properly

inserted
Operator #, ENT
Enter 1D# Below

Enter an Operator 112 Do not attempt to remove
the simulator until the LCK
prompt disappears from the

LCK screen.

Time to Results

Operator#, ENT

ELECTRONIC Remove the simulator. If PASS If FAIL is displayed, see
SIMULATOR is displayed, continue to use the | Troubleshooting section

analyzer. below. Record results in log
PASS

or transmit results to Central
Data Station. Replace the blue
cap if applicable. Replace the
simulator in a protective box
or plastic bag.

READY FOR USE

Operator ID #
Time and Date

Caution

The analyzer will continue to initialize test cycles when the external Electronic
Simulator reminder is missed, when a FAIL result for an external Electronic
Simulator is ignored, and when the analyzer fails the internal Electronic
Simulator test and the lockout feature is not enabled.

TROUBLESHOOTING FAILED ELECTRONIC SIMULATOR TEST

Introduction

External Simulator

With both the internal and external Electronic Simulator, an analyzer may
occasionally fail a simulator test even though it is in proper operating
condition due to the extremely sensitive nature of the test.

Run the test again or try another simulator, as it is possible that the test will
pass on a second try. The test can also fail if the external Electronic Simulator
is malfunctioning such as after being dropped.

Occasionally when an analyzer is moved from a cold environment to a warm,
humid environment, moisture may condense on the internal connector. An
analyzer in this condition will fail the electronic test and the failure code
“L” will be displayed. Allow the analyzer to sit for halt an hour to allow the
moisture to evaporate, then insert the Electronic Simulator again. If the
analyzer passes the second electronic test, continue using it. If the analyzer
fails the second time, record the letter or Quality Check Code displayed
with the FAIL message and refer to Support Services information in the
Troubleshooting section.
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Internal Simulator

Lockout Enabled: Rerun the cartridge in the same analyzer to ensure the
FAIL was not due to a one-time spike of electrical noise. If the test fails again,
rerun the cartridge in another analyzer if immediately available. Note that the
cartridge should not be run if there is more than a three minute delay from the
time it is filled. If the cartridge fails in more than one analyzer, use another
cartridge. When Lockout is enabled, the analyzer will continue to perform the
internal Electronic Simulator test each time a cartridge is inserted until the test
(internal or external) passes.

Lockout Not Enabled: Rerun the cartridge in another analyzer if immediately
available. Note that the cartridge should not be run if there is more than a
three minute delay from the time it is filled. When Lockout is not enabled, the
analyzer will run the next cartridge without performing the internal Electronic
Simulator test until the specified time has elapsed. Verify the analyzer using an
external Electronic Simulator.

CHECKING THE THERMAL PROBES IN THE i-STAT ANALYZERS

Verification for
Portable Clinical
Analyzers

Rev. Date: 08/23/06

Verify the thermal probe check for the i-STAT Portable Clinical Analyzer and i-
STAT 1 Analyzer as follows:

* External Electronic Simulator used routinely and results transmitted to
a Central Data Station Version 4: On the CDS, click on System, then on
Simulator Results. Look under the Delta column. Check that there is
a value equal to or less than 0.1 (< 0.1) listed for each analyzer in use
in the last 30 days. A value of “----” indicates that the conditions to
complete the thermal probe check were not met. Use the procedure
below to check any analyzer that does not have a numeric value listed.

¢ [External Electronic Simulator used routinely and results transmitted to
a Central Data Station Version 5: On the CDS, click on Data Viewer,
then on Simulator. Look under the Probe Delta column. Check that
there is a value equal to or less than 0.1 (< 0.1) listed for each analyzer
in use in the last 30 days. A value of “--.--” indicates that the conditions
to complete the thermal probe check were not met. Use the procedure
below to check any analyzer that does not have a numeric value listed.

e External Electronic Simulator used routinely, results not transmitted to
a Central Data Station: Use the procedure below to check the thermal
probes on each analyzer twice a year.

* Internal Electronic Simnulator used routinely: Use the procedure below
to check the thermal probes on each analyzer twice a year.

Art: 715014-00E

12-11



Procedure for Check the thermal probes on the i-STAT Portable Clinical Analyzer and i-STAT 1
Portable Clinical Analyzer as follows:

Analyzers

1

If the analyzer and simulator have been stored separately in areas
where the ambient temperature differs by more than 3°C (5°F), allow
the simulator and analyzer to stand in the same place, out of drafts, for
30 minutes before inserting the simulator into the analyzer. Handle
the simulator as little as possible to maintain its thermal uniformity
and stability.

Insert the simulator into the analyzer.

When results are displayed, the difference between the thermal probes
can be viewed on the analyzer’s screen:

¢ Portable Clinical Analyzer: while holding down the DIS key, press
the 1 key.

e i-STAT 1 Analyzer: press the period key.

Interpretation of the thermal probe check value:
* Acceptable: a value equal to or less than (0.1 (£ 0.1)

* Not acceptable: a FAIL message with a “t” Quality Check Code or
a value greater than 0.1. Repeat the procedure to confirm results.
Contact your Technical Support representative if the repeat thermal
check value is greater than 0.1.

* Repeat the procedure: if “--.--" is displayed. Take care to handle
the simulator a little as possible. It may help to partially insert the
simulator into the analyzer and let it stand for 15 minutes before
inserting all the way.

Verification of BAMs  Verify the thermal probe check on a Philips Medical Systems Blood Analysis
Module (BAM) and Central Data Station Version 5 as follows:

12-12

External Electronic Simulator used daily and results transmitted to a
Central Data Station Version 5: On the CDS, click on Data Viewer,
then on Simulator. Click on Record in the Main Menu, then click
on Extended Electronic Simulator Report. Look under the Pot6P
column. Check that there is a value equal to or less than 0.1 (< 0.1)
listed for each BAM in use in the last 30 days. No recorded value
indicates that the conditions to complete the thermal probe check were
not met. Use the procedure below to check any BAM that does not
have a numeric value listed.

Internal Electronic Simulator used routinely: Use the procedure below
to check the thermal probes on each BAM twice a year.

Art: 715014-00E Rev. Date: 08/23/06



Procedure for BAMS  Check the thermal probes on a BAM as follows:

Documentation of

Results

1. Insert the simulator partially into the BAM and wait for 15 minutes
before inserting the simulator all the way into the BAM. Handle the
simulator as little as possible to maintain its thermal uniformity and
stability.

2. When results are displayed, transmit the results to the Central Data
Station.

3. View the probe check value on the CDS:

1)
2)
3)
4)
S)

Click on Data Viewer

Click on Simulator

Click on Record in the Main Menu task bar
Click on Extended Electronic Simulator Report

Look under the Pot6P column

4. Interpretation of the thermal probe check value:

Acceptable: a value equal to or less than 0.1 (£ 0.1)

Not acceptable: a FAIL message with a "t" Quality Check Code or a
value greater than 0.1. Repeat the procedure to confirm the results.
Contact your Technical Support representative if the repeat thermal
check value is greater than 0.1.

No value: repeat the procedure. Take care to handle the simulator
as little as possible. It may help to increase the time in step 2 to 30
minutes.

The results of the thermal probe check are stored in the Central Data Station.
If the Central Data Station is not available, use the form included with this
Technical Bulletin to record the results.

PROCEDURE TO CHECK ROOM TEMPERATURE MEASUREMENT

Rev. Date: 08/23/06

Place the analyzer with a calibrated thermometer suspended near the analyzer and
away from air currents for one hour.

Check the temperature reading on the Analyzer status page. The temperature should
be £ 1 °C of the thermometer’s reading.

Art: 715014-00E
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i-STAT System Incoming Cartridge QC Log

CatridgeType: LotNo.: Rec'd Date: Exp.Date: Quat: Temp. Strip*:

Control Name: Level: Lot No.: Exp. Date:

TEST TEST TEST TEST TEST TEST TEST TEST
RANGE RANGE RANGE RANGE RANGE RANGE RANGE RANGE
Control Name: Level: Lot No.: Exp. Date:

TEST TEST TEST TEST TEST TEST TEST TEST
RANGE RANGE RANGE RANGE RANGE RANGE RANGE RANGE
Control Name: Level: Lot No.: Exp. Date:

TEST TEST TEST TEST TEST TEST TEST TEST
RANGE RANGE RANGE RANGE RANGE RANGE RANGE RANGE
Control Name: Level: Lot No.: Exp. Date:

TEST TEST TEST TEST TEST TEST TEST TEST
RANGE RANGE RANGE RANGE RANGE RANGE RANGE RANGE

Lot/Shipment accepted by:

Date:
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i-STAT System QC Log
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L]

Expiration Date and Storage Conditions

REFRIGERATED

REFRIGERATED

2TO8 C(35TO 46" F)

2TO B C(35TO 46° 1)

EXP.
DATE

~ TEMP

. ACTIONS
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i-STAT Carirdige Quality Control Action Log
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Analyzer Serial No.:

i-STAT Analyzer Thermal Probe Check

SIMULATOR SERIAL | THERMAL PROBE DELTA RESULT
DATE ND. (LIMIT: % 0.1° C) COMMENTS OPERATOR
Analyzer Serial No.:
SIMULATOR SERIAL | THERMAL PROBE DELTA RESULT )
DATE iy (LIMIT: 1 0.1° C) COMMENTS OPERATOR
Analyzer Serial No.:
SIMULATOR SERIAL | THERMAL PROBE DELTA RESULT
DATE = (LIMIT. £ 0.1° O) COMMENTS OPERATOR
Analyzer Serial No.:
SIMULATOR SERIAL | THERMAL PROBE DELTA RESULT
DATE XO. (LIMIT: £ 0.1° C) COMMENTS OPERATOR
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i-STAT Electronic Simulator Log for Analyzer Serial Number:

Year:

] S

MULATOR
D

TIME

- PASS
“FAIL |

SIMULATOR

IB o
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i-STAT Electronic Simulator Action Log




CALIBRATION VERIFICATION FOR ANALYTES

CALIBRATION VERIFICATION FOR BLOOD GAS/ELECTROLYTE/METABOLITE CARTRIDGES

Purpose

Overview of
Procedure

Calibration
Verification Solutions
for Cartridges

Reactive Ingredients

Storage

Ampule Use

Best Results

Art: 715015-00F

Calibration Verification is a procedure intended to verify the accuracy
of results over the entire measurement range of a test. The performance
of this procedure at defined intervals may be required by regulatory or
accreditation bodies. While the Calibration Veritication Set contains five
levels, verification of the measurement range could be accomplished using
the lowest, highest and mid levels.

i-STAT recommends that each sensor type be included in the Calibration
Verification procedure using a selection of the analyzers that have passed
the Electronic Simulator check. See the Technical Bulletin "Calibration
Verfication and the i-STAT System" for more information.

A five-level Calibration Verification Set is available to verify the calibration
of i-STAT cartridges throughout the reportable ranges for:

Sodium pH Glucose
Potassium PCO, Lactate
Chloride PO, BUN/Urea
lonized Calcium Creatinine

There are four 1.7mL glass ampules of each level in the set.

See the table on page 12-2 of the Quality Control section for full
information.

Refrigerated storage at 2 to 8 °C (35 to 46°F) should be maintained until
the printed expiration date on the box and ampule labels. Calibration
Verification fluids may also be stored at room temperature for up to 5 days
(18 to 30 °C or 64 to 86°F). Prolonged storage at temperatures greater than
30 °C (86°F) may cause changes in the values of some analytes. Do not use
beyond the expiration date on the box and ampule labels.

When using cartridges that contain sensors for pH, PCO,, PO, and ionized
calcium, a separate ampule must be used for each cartridge being tested. If
these sensors are not present, the contents of one ampule may be used to fill
more than one cartridge as long as the cartridges are filled and inserted into
an analyzer within 10 minutes of opening the ampule.

For best results, ampules, cartridges and analyzers should be at the same
temperature.

Rev. Date: 08/23/06
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i-STAT CALIBRATION VERIFICATION SET

Before Use

Procedure

Transfer with
Capillary Tube

Transfer with Syringe

i-STAT Calibration Verification solutions require different temperature
stabilization times depending on whether or not oxygen is to be measured.
If oxygen is to be measured, equilibrate the ampule to room (ambient)
temperature for 4 hours. If not, equilibrate the ampule to room (ambient)
temperature for 30 minutes.

L L A BT T WP ket ALTION

1 Immediately before use, shake the ampule vigorously for 5 to
10 seconds to equilibrate the liquid and gas phases. To shake,
hold the ampule at the tip and bottom with forefinger and
thumb to minimize increasing the temperature of the solution.
If necessary, tap the tip of the ampule to send solution back into
the bottom section of the ampule.

2 Protect fingers with gauze, tissue or glove, or use an ampule
breaker to snap off the tip of the ampule at the neck.

3 Immediately transfer the solution from the ampule into a plain
capillary tube or plain syringe, and then immediately transfer the
solution into a cartridge.

-+ Immediately seal the cartridge and insert it into an analyzer - it
is important not to expose the solution to room air since this will
alter the results.

Note: Since aqueous based solutions such as controls lack the buffering
capabilities of whole blood, the transfer process from ampule to
cartridge must be more expedient than with a patient sample.

Plain capillary tubes are recommended to transfer aqueous calibration
verification material from the ampule to the cartridge. When using a
capillary tube (fresh capillary tubes with sufficient fill capacity are
recommended), fill from the bottom of the ampule.

Avoid drawing solution from the surface by placing a finger over the far end
of the tube as it is inserted into the ampule.

Once the open end of the tube rests at the bottom of the ampule, uncover
the other end to allow filling by capillary action.

Plain syringes are recommended to transfer aqueous calibration verification
material from the ampule to the cartridge. When using a syringe (fresh lcc
or 3cc sterile syringes with 16 - 20 gauge needles are recommended), slowly
draw approximately 1mL of solution from the bottom of the ampule.

If air is trapped between the leading edge of the solution and the plunger, do
not invert the syringe to expel it; this will not affect solution near the front
of the syringe.

If air bubbles are continually drawn into the syringe, or if a bubble is trapped
near the tip of the syringe, discard the ampule and syringe and use a fresh
ampule and syringe.

Expel one or two drops from the syringe before filling the cartridge.

Art: 715015-00F Rev. Date: 08/23/06



Acceptable Criteria Target values (determined by testing multiple ampules of each level using multiple
lots of i-STAT cartridges with analyzers that have passed the Electronic Simulator
test) and acceptable ranges are printed on a Value Assignment Sheet included with
each Calibration Verification Set.

Calibration throughout the reportable range of each analyte is verified if each
analyte value falls within the corresponding range in the Value Assignment Sheet.

If the result for a level is outside the range published in the Value Assignment
Sheet, two additional cartridge runs should be performed on this level and the
three results averaged and then compared to the Value Assignment Sheet range.
If this average value is still outside the acceptable range, troubleshooting may be
required.

Note: If the Calibration Verification Set is to be used to assess linearity, plot
the analyte value against the mean value of the acceptable range. The
concentrations of analytes in the Calibration Verification Set are not
intended or prepared to be equally spaced.

If testing at extreme altitude refer to Correction of PO, at Extreme Altitude under
Controls for Blood Gas/Electrolyte/Metabolite Cartridges in the Quality Control
section of the manual.

RNA® MEDICAL HEMATOCRIT CALIBRATION VERIFICATION CONTROL

Intended Use RNA Medical Hematocrit Calibration Verification Control is a quality control
material used for verifying the calibration and linearity of hematocrit sensors in
i-STAT cartridges.

Product Description Hematocrit Calibration Verification Controls are provided in five (5) levels for
verifying the accuracy of hematocrit measurements throughout the reportable
range. The controls are packaged in sealed glass ampules, each containing 1.7
mL of solution. Ampules are packaged in kits containing four (4) ampules of
each level.

Active Ingredients This product is a buffered aqueous solution containing electrolytes and non-
conductive ingredients. This control contains no red blood cells, and no human
or biological material.

Storage RNA Medical Hematocrit Calibration Verification Control is stable until the
expiration date stated on the ampule when stored at temperatures of 2-25 °C.
Do not freeze or expose ampules to temperatures greater than 30 °C.

If stored refrigerated, the calibration verification material should be
equilibrated to room temperature for at least four (4) hours prior to testing.

The product may turn slightly yellow in color over its shelf life if stored at
room temperature. This coloration is normal and does not affect product
performance.

Directions For Use 1. Beginning with Level 1, gently invert the ampule to mix the solution.
Tap the ampule to restore the liquid to the bottom of the ampule.

2. Open the ampule by snapping off the tip at the neck. Use gauze,
tissue, gloves, or an appropriate ampule opener (a Snapper is included
for this purpose) to protect fingers from cuts.

3. Fill and seal a cartridge and insert immediately into the analyzer.

4. Record the results on the Data Collection and Linearity Worksheet
provided.

Rev. Date: 08/23/06 Art: 715015-00F
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7.

Test Levels 2, 3, 4, and 5 in the same manner. Record all values on
the worksheet.

i. Note: this product is a butfered aqueous solution containing
electrolytes and non-conductive ingredients. The only value
assigned to this fluid is for hematocrit. All other cartridge analyte
results obtained with this control material should be ignored.

Compare the the i-STAT System Hematocrit result value for each level
to the package insert value.

i. If your result is within the assigned value range, circle Y at the
question OK?.

ii. If the result is outside of the expected range, run two (2) additional
cartridges.

a. Report the mean of the three (3) results.

b. 1f your mean is within the assigned value range, circle Y at the
guestion OK?.

c. If this result is also out of the expected range, circle N and
contact your i-STAT Support Representative.

If available, transmit results to the Central Data Station.

VERIFICATION PROCEDURE FOR HEMATOCRIT

Preparation of
Hematocrit Samples

Measurement

5.

Draw 4 lithium heparin green top tubes trom a fasting person with a
normal hematocrit or MCHC. 7mL vacuum tubes are suggested. Label
the tubes 1, 2, 3, and 4.

Centrifuge tubes 3 and 4 for 10 minutes at 3,000 rpm to pack the
cells.

Remove two thirds the volume of whole blood from tube 1. This
blood should be held in a clean plain tube in case it is needed to
make adjustments later.

Transfer all of the plasma from tube 4 to tube 1.

Remove three fourths of the plasma from tube 3. This plasma
should be held in a clean plain tube in case it is needed to make
adjustments.

Gently invert tubes 1, 2 and 3 to resuspend the cells.

Measure the hematocrit of the blood in tubes 1, 2, and 3 using one
cartridge for each tube. Adjust the hematocrit in tube 1 until it reads
close to, but not less than, 10%. Adjust the hematocrit in tube 3 until
it reads close to, but not more than, 75%.

Gently invert tubes 1, 2, and 3 to resuspend the cells.

Measure the hematocrit of the blood in tubes 1, 2, and 3 three times
each by the i-STAT and microcentrifuge methods.

Inspect the data for outliers. Repeat a measurement if necessary.

Calculate the mean of the three measurements of the three
hematocrit levels for both methods.
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Interpretation of
Results

Notes on the
Procedure

Using Another
Comparative Method

Reference Method

The i-STAT hematocrit method using blood anticoagulated with
lithium heparin is calibrated to give results equivalent to the reference
microhematocrit method using blood anticoagulated with K,EDTA. Since
the blood used for the microhematocrit determination here is anticoagulated
with lithium heparin, adjustment must be made to the observed i-STAT
values to compensate for the anticoagulant difference.

1. To calculate the adjusted i-STAT hematocrit mean, multiply the mean
of the observed i-STAT results by 1.0425.

2. The adjusted i-STAT hematocrit mean should be within +3%PCV of
the microhematocrit mean.

For example: the microhematocrit method mean for the mid level
sample is 36%PCV. The i-STAT method mean is 34%PCV. 34 x
1.0425 = 35.445. Acceptable range for the adjusted i-STAT mean: 33
- 39%PCV.

Note: If your analyzers are customized for K,EDTA/Heparin/None, the
above calculation is unnecessary.

1. If a higher hematocrit value is needed in tube 1 or 3, packed cells can
be obtained by centrifuging the whole blood retained from tube 1 in
step 3. If a lower hematocrit value is needed, add plasma retained in
step 5.

2. The highest hematocrit that should be tested on the i-STAT System is
75%. Whole blood samples with hematocrit values greater than 75%
will be flagged as >75. The lowest hematocrit that should be tested
on the i-STAT System is 10%. Whole blood samples with hematocrit
values less than 10% will be flagged as <10.

Methods other than the reference microhematocrit procedure may be used
to verify calibration and reportable range of the i-STAT hematocrit. However,
the following requirements apply:

e Blood should be drawn from a fasting donor with a normal
hematocrit and a normal MCHC (calculated from hemoglobin and
hematocrit values determined using reference methods) and be free
of specific interferences which degrade the accuracy and/or precision
of the alternative comparative method or the i-STAT method.

* Calculation of results must correct for any systematic bias between
the reference microhematocrit method and the alternative
comparative method selected.

NCCLS recommends that the blood samples anticoagulated with Na,EDTA
or K,.EDTA be used for the microhematocrit method.* However, EDTA will
interfere with the electrolyte measurements which are used in the calculation
of hematocrit results on the i-STAT System.

* NCCLS. Procedure for Determining Packed Cell Volume by the Microhematocrit
Method; Approved Standard- Third Edition. NCCLS document H7-A3
(ISBN 1-56238-413-9). NCCLS, 940 West Valley Road, Suite 1400, Wayne,
Pennsylvania 19087-1898 USA, 2000.

VERIFICATION PROCEDURE FOR ACT

Rev. Date: 08/23/06

See Technical Bulletin: i-STAT Celite and i-STAT Kaolin ACT Heparin Linearity
Procedure

Art: 715015-00F
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Procedure for
Cartridges

Calibration Verification and linearity solutions can be tested via a test path
accessed from the Utility menu on the i-STAT Portable Clinical Analyzer. (This
test path is not available on the BAM.) The same standardization CLEW is used
to calculate both patient sample results and calibration verification/linearity
sample results. The difference is that in the Calibration Verification test path,
the application software does not apply measurement range flags so that results
for samples below and above the measurement ranges can be reported.

Note: Because the Utility menu also includes a Clear Stored Results option,
it may not be wise to give end users access to the Utility menu.

The ID # (corresponds to Patient ID # in the standard test path) can be used
to identify these samples and the cartridge lot number. Note that each of the
five levels in the i-STAT Calibration Verification kit has its own lot number.
The lot number for Level 1 can be used to identify the kit or each lot number
can be used to identify each sample. The letters in the Calibration Verification
and cartridge lot numbers can be ignored. For example: Cal Ver level 1 and lot
number 1109 plus cartridge lot 02089: 1110902089.

Note: Samples should be prepared and ready to test before starting this
procedure since the analyzer will wait for only 5 minutes after the
“INSERT CARTRIDGE” message is displayed before powering down.

Display

OFF (blank) or ON with a
result displayed.

Insert Electronic Simulator

Electronic Simulator test
cycle will commence.

Electronic Simulator PASS
result displayed.

Hold down the DIS key and
press the MENU soft key.

Utility Menu will be
displayed.

Utility Menu

1 Clear Stored Results
2 Printer Setup

3 Send Software

4 Cal Ver

5 Proficiency

Press 4 for Cal Ver

Insert cartridge prompt will
be displayed.

Cal Ver

INSERT CARTRIDGE

Insert filled cartridge into
analyzer cartridge port.

If the display turns OFF
before the cartridge is
inserted, turn the analyzer
ON using the DIS key. You
must re-enter the Utility
menu and select the Cal Ver
option before inserting the
filled cartridge.

Test cycle will commence. If
at any point during the test
cycle a quality check fails,
the test cycle will halt and

a message will be displayed
indicating the condition and
the corrective action.

Operator #, ENT

Enter Operator 1D and press
ENT.

Repeat #, ENT

Repeat Operator 1D and press
ENT.

Repeat of Operator 1D
entry may not be required
depending on analyzer
customization settings.

If the repeated ID does not
match the original, the ID
must be re-entered.

Art: 715015-00F
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Troubleshooting
Cartridge Tests

Rev. Date: 08/23/06

Repeat #, ENT

. O Enter sample 1D and Press

ID, ENT e
Repeat the sample 1D Repeat of sample 1D entry
number and press ENT. may not be required

# depending on analyzer

customization settings.

If the repeated ID does not
match the original, the 1D
must be re-entered.

Select Tests

(Available tests will be
dependent on cartridge
type).

Use the number keys to
select tests to be reported.
(Press a number key a second
time to deselect a test.)

Press PAGE key when all
desired tests are selected.

Test selection may not be
required depending on
analyzer customization
seltings.

Chart Page

Use the number and
ENT keys to enter test
information if desired.

Press PAGE key when
all information entry is
complete.

Automatic display of the
Chart Page is dependent
on analyzer customization
settings.

Results Displayed

If results are not displayed,
but RESULTS READY message
is visible, press the PAGE

key until the results page is
shown.

Remove the cartridge and
discard in a biohazard
container.

Print or transcribe results.

Analyzer unlocks cartridge
and is ready for another
cartridge.

If another cartridge is
inserted into the analyzer
without pressing DIS and
MENU, it will be run as

a patient sample. To run
another Cal Ver sample

continue to next instruction.

Results Displayed

To run another Cal Ver
sample, hold down the DIS
key and press the MENU key.

Utility Menu will be
displayed.

Utility Menu
1 Cal Ver

2 Proficiency

Press 1 for Cal Ver

Insert Cartridge prompt will
be displayed.

Follow sequence from the
Insert Cartridge screen as
shown above to complete
the test cycle.

See the Troubleshooting Out-of-Range Results paragraph in the Quality Control

Section in this manual.

Art: 715015-00F
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CENTRAL DATA STATION 5

ABBOTT POINT OF CARE INC. LICENSE AGREEMENT AND WARRANTY FOR CENTRAL DATA

STATION PROGRAM

EULA

License

Warranty

Rev. Date: 07/18/06

For new users of CDS software the license and warranty information in the End
User License Agreement (EULA) will be in effect.

The i-STAT Central Data Station software is licensed to the authorized user
by Abbott Point of Care Inc.. Portions of the software are licensed to you
by Abbott Point of Care Inc. under sublicense from other original software
providers. By accepting and using this software, the user/licensee agrees to
the following:

* The user/licensee will not make copies of the software programs or any
of the program software files generated by the programs, the manual or
other documentation except for archive copies made as part of user/
licensee’s regular back-up procedures.

* The user/licensee will protect the programs from unauthorized use,
illegal reproduction (including reproducing any of the software files
generated by the programs) or illicit distribution.

* The user/licensee will not change or reverse engineer the programs or
any of their software files by debugging, decompiling, disassembling,
reprogramming, rewriting the programs’ macros, revising the programs’
forms or any other means.

If the user/licensee makes any use, transfer or disclosure of the programs in
violation of any of the foregoing, the sub-license .will, at the option of Abbott
Point of Care Inc., immediately terminate without demand or notice and the
user/licensee will immediately give to Abbott Point of Care Inc. the programs,
the manuals and all copies thereof in the user/licensee’s possession.

Abbott Point of Care Inc. warrants the licensed software and accompanying
physical documentation to be free of defects for a period of thirty days from
the date of installation. If notified of defects within the warranty period, Abbott
Point of Care Inc. will replace the defective software or documentation as
soon as practical for the nature of the defect. The remedy for breach of this
warranty is limited to replacement and shall not encompass any other damages
including but not limited to loss of profit, and special, incidental, consequential
or other similar claims. Abbott Point of Care Inc. specifically disclaims all other
warranties, expressed or implied, including but not limited to implied warranties
of merchantability and fitness for a particular purpose, with respect to the
software, accompanying documentation and the license granted herein.

Art: 715021-00C
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INSTALLATION OF THE CENTRAL DATA STATION

Hardware

Software
installation:
License Key

Caution

Site Specific
Customization of
the CDS

Rev. Date: 07/18/06

The PC on which the CDS software resides must meet specifications
provided by Abbott Point of Care Inc. and should be installed following the PC
manufacturer’s directions. Install the printer if applicable.

A license key is required to install the Central Data Station software. The
license key ensures that the end user agrees to the License Agreement which is
displayed during installation. To obtain the license key, follow the instructions on
the screen and listed below.

1. Insert the CDS CD and the installation will begin automatically.
2. Click Next> in the Welcome dialog.

3. The End-User License Agreement will be displayed. Read the
agreement and if you agree to abide by the agreement, click Yes to
proceed with the installation. If you do not agree, click No to abandon
the installation.

4. Record the serial number of the CDS displayed in the Enter License Key
dialog.

5. Go to the Abbott Point of Care Inc. web site at http:/www.
abbottpointofcare.com and click on the i-STAT panel in the lower left
corner of the screen. Click on the link under CDS Key Generator in the
right hand column. You can also access this link directly at http:/www.
abbottpointofcare.com/cdslicense. (In the USA, the license key can
also be obtained from Technical Support.)

6. If you are already registered, skip to step 8. If you are not registered, fill
out the required information, select Basic Access, and click Register.

7. Go back to the i-STAT web site as directed in step 5.
8. Enter your username and password and click Login.

9. You may now enter the serial number recorded in step 4, and click
Submit.

10. If successful, a message will appear indicating that your key has been
e-mailed to the address with which you registered.

11. Obtain the key from the e-mail and enter it in the space provided on the
CDs.

12. Click Next to proceed with the installation.

The use of other software that was not provided as part of the system on the
same PC with the Central Data Station software may compromise the system,
including permanent loss of patient records.

During installation, the CDS must be customized to properly communicate
with i-STAT 1 Downloaders and Downloader/Rechargers, i-STAT IR Links and
Philips Medical Systems Blood Analysis Modules throughout the hospital. The
procedure to customize the CDS is described under the Customization section
below.

Art: 715021-00C
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Connectivity

Interface

The date displayed with results can be changed to any Short Date format and
separator listed in the computer’s Control Panel under Regional Options (or
something similar, depending on the version of Microsoft Windows in use). If an
unsupported format or separator is detected, the user will be notified and given
the opportunity to change to a supported format/separator combination.

Basic information needed to connect the Downloaders, Downloader/
Rechargers, and the portable printer to the PC are in the Downloader Wiring and
Programming section of this manual.

For assistance in programming the Downloader, Downloader/Recharger and IR
Links, contact your i-STAT support representative.

Basic information on interfacing can be found in the "Interface" paragraph under
"Customization of the Central Data Station" in this section of this manual and in
section 8.
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GENERAL PROCEDURES AND CONVENTIONS

Overview The CDS software follows typical Microsoft® Windows® conventions and
procedures. The illustrations below are used to point out the use of the menu
bar, toolbars, tabs and buttons.

Selecting Menu Clicking an item on the menu bar (1) will drop down the menu for that item. |If
Options any of the items in the drop down menu has a submenu, the submenu will open
to the right of the »symbol next to the item when the item is highlighted (2).

Clicking the desired menu option will open the item’s window or will perform
the item’s function. The menu items and toolbar for the active window will be
displayed (5).

TR
Pietision PCx
LSTAT s
| eTAT E 1UZH000 5223001

R 11 1

142200000 8220001
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Selecting Functions Tabs: A window may have several functional groupings that are contained

in a Window

Refreshing/
Updating the Data
in a Window

in tabs (6) with multiple pages. Clicking the text on the tab will display the
corresponding page.

Buttons: Use to activate a function within a window (7) or to confirm (OK) or
cancel a function or to manipulate a window. All windows can have the following
buttons in the upper right hand corner (8):

Hana01 11 %8
FJan2001 1156
30Jan2001, 1154
G0dan2007 11:54
30Jan2001 09 37
AJan2001 09.37
J0dan2001 0926
30Jan2001 0936
SllJan2001 (935
Hban2001 02926
30Jan2001 0935
IJan2001 0935
29Jan2001 17.32

'Insi'rufnenl <et to repon locaton asswnment
Instrument moved from Paol to NICU
Simutator FAIL "R", RGA1234

Instrument moved from NICU to Returnad
Instrurnent sdded to location Poal
Instrument zdded to location NICU
Instrument <et to report location assignment
Instrument <el to report location assignment
Instrument added to location NICU

Inztrument added to location CVOR

Instrument added to locasbion CVOR o
Instrument added to location CVOR

Instrument deleted

This button causes the window to be maximized.
This button causes the window to be minimized.
This button causes the window to be moveable and resizable.

This button causes the window to close.

If a window does not have a close button, it can be closed by selecting Main
then Close on the menu bar.

Check boxes: Click the box to enable or disable a single option (9).

Radio buttons:
options.

Click the circle to select from a list of mutually exclusive

Highlight bar: Use to select the line or lines on which to apply a function (10).

Drop down list: Click the v button to drop down a list or scroll downward in a
window.

The Refresh toolbar button @ refreshes the data content in the active window
with the most recent data available. The refresh function is also available under
the Window option on the menu bar. Pressing F5 will also refresh the data.
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Sorting Data in a
Window

Selecting Multiple
Lines

Opening Multiple
Windows

Column Ordering

Column Widths

Toolbars

Helpful Hint!

Rev. Date: 07/18/06

In most cases, when data is presented in a table, clicking a column header will
sort the display based on the data in that column. In the Data Viewers, repeating
values, such as a patient ID, will be sorted in descending Date/Time order.
Clicking the header again will reverse the order of the sort. To return the data to
chronological order, click the Date-Time column header.

In many functions, multiple lines can be selected for the desired action. To
select consecutive multiple lines, click the first line and, while holding down the
Shift key, click the last line. To select multiple lines that are not consecutive,
click the desired lines while holding down the Cirl key.

Multiple windows can be open at the same time. The Windows item on the
menu bar can be used to select the desired window from the list of open
windows and bring it to the forefront. Close windows by clicking the Close
button at the top right of the window or by selecting Close from the Main menu.

Columns in the Data Viewers can be placed in any order. Use the mouse to grab
a column header and drag the column to the desired position.

To adjust a column’s width in Data Viewers, place the mouse pointer on the edge
of the column header. When the mouse pointer turns into two arrows, hold the
left mouse key and drag column to the desired width.

Select Tools r> Customize Toolbars... to select options for the way toolbars
appear. Checking Large Buttons displays descriptive text under toolbar
buttons. This may be helpful while learning the application. Checking Show
Tooltips displays a description of a button when the mouse pointer is placed
over a toolbar button.

Art: 715021-00C
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CUSTOMIZATION OF THE CENTRAL DATA STATION

Overview

Site Information

Rev. Date; 07/18/06

The Customization options are:

Site Information  Institution name and technical support phone number

Serial Ports Enables/Disables serial communications and allows
individual ports to be selected and configured

Network Enables/Disables network communications and allows
specification of TCP port numbers

Interface Enables/Disables external interfacing and allows protocol to
be selected

Options Allows various general system behaviors to be specified

Security Enables/Disables the CDS Security features which allow

for the creation of security profiles providing different
levels of access to various areas and functions of the CDS
application.

To access the Customization screen, close the CDS application, access the
Run dialog box by clicking Start > Run.... Type weds32 config at the Open:
prompt, then click OK.

If Run... is not on the Start menu, double click the Command
Prompt shortcut. At the C:\> prompt in the window that opens, type
c:\istat32\bin\wcds32.exe config and press Enter.

When the Customization screen appears, click a tab to display the desired
tab page. The information in each field can be specified. When all tabs are
customized as desired, click the Accept button to save the information. Click
the Reset button to disregard changes and restore the previous information.
Click the Cancel button to ignore any changes and retain the current settings.
When customization is complete, the CDS application will open automatically.

A site name and address of up to 60 characters can be entered into this field.

The appropriate Technical Support Phone Number for the country will be listed
or can be entered.

Art: 715021-00C
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Serial Ports

Network

The Central Data Station program resides on a PC with multiple serial ports
(DBY). Available ports will automatically be listed under Available Ports on
the Serial Ports tab page. The following components can be connected to the
Central Data Station via serial ports:

[} i-STAT Series 200 Analyzer: IR Link transmits data to and from the
i-STAT Portable Clinical Analyzer.

[} i-STAT Series 300 Analyzer: Downloader or Downloader/Recharger
transmits data to and from the i-STAT 1 Analyzer.

(1 Philips Module: a local connection to the CDS is needed to transmit
software updates and customization profiles to the Blood Analysis
Module.

(] Philips CDS: The CDS server transmits patient data from the Blood
Analysis Module to the Data Manager.

Click the Enable serial communications box to check it and enable serial
communications.

Click the desired port(s) under Available Ports and click the <<<<Add button.
The port(s) will now be listed under Configured Ports.

li3-STAT Central Data Statio

. sie iermanon Senal Foits 1_1-;#.—;&33 | Gppons | Secunty|

S e Phas
COM3

Serial ports on the PC might also be needed for a local PCx Docking Station and
connection to an interface.

Click the Enable network communications box to check it and enable network
communications.

The default TCP service port assignments are listed in the Network tab page. If
not using the default ports, click the port and type in the new assignment. Port
numbers must be unigue and in the range of 1024 to 65535.

Note: If a PCx Docking Station is sharing the ethernet port with an i-STAT
Downloader, the PCx port assignment is made in QC Manager.
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Interface

The appropriate interface protocol and the types of records to be sent to
another data management system are selected in the Interface tab page. This
configuration will typically be done by the interface provider.

Select the desired primary interface protocol. Then select the result types to be
sent to the interface.

[Mone] ¥ Test Resul
AME
AETM

I Electronic Sirulatar
T Control Result

I~ Calver Result

T Proficiency Recult
I Other Resufts

¥ Data File
HLT

.(.‘.’:i.ﬂ;cai ii

Primary Interface Explanation Which Result Type(s)
Protocol Choices May be Transmitted
None Indicates no primary protocol in use. Select when no external interface is used N/A
and PCx glucose test strip data is to be uploaded to QC Manager 3
AME Automatic Manual Entry — Installed by Abbott Point of Care Inc. 1. Test Result
2. Electronic Simulator
3. Control Result
4. Cal/Ver Result
5. Proficiency Result
ASTM Data Transmission conforms to ASTM E1381-95 and ASTM E1394-97 Patient Test Results ONLY
Data File Formats the CDS for third-party use. 1. Test Result
2. Electronic Simulator
3. Control Result
4. Cal/Ver Result
5. Proficiency Result
HL7 Data transmission conforms to HL7 (version 2.4) and is based on the CIC Patient Test Results ONLY
Observation Reporting Interface distributed by the National Committee for
Clinical Laboratory Science in the USA under Document POCT-1-A. This option is
installed by Abbott Point of Care Inc.

Rev. Date: 07/18/06

Click Enable external interface box to check it and enable this function.

Click Enable AutoSend box to check it and enable this function. When
AutoSend is enabled, new records will be automatically sent from the Central
Data Station to another data management system whenever they are received
by the Central Data Station. Checking this box will cause the CDS program
to start up with AutoSend enabled on startup. AutoSend can be temporarily
enabled/disabled from the CDS program as well. Records can also be sent
manually from the Data Viewers.
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Options

When MediSense Precision PCx glucose test strips are being run on the i-STAT 1
Analyzer, the glucose test strip data can be made available to QC Manager data
management program. Click the Upload PCx Strip Data to QC Manager 2.2
box to enable this function.

Confirmation message on exit: When this option is enabled, a confirmation
message is displayed prior to exiting the CDS program.

Enable use of IR Link IDs: When enabled, the IDs programmed into the IR
Links are used in determining the download location of the results instead of the
actual serial port or IP address. To use this function, all IR Links must be of the
self-identifying type. This option is not typically used but is available in case the
functionality is needed.

Accept previously deleted records: When disabled, this option prevents
previously deleted records from being stored when re-transmitted to the Central
Data Station.

Monitor refresh: The status reports in the Download and Interface Monitors will
be updated after the period of inactivity specified.

Maximum diagnostic files: Diagnostic files contain information that can be
useful in troubleshooting cartridge problems. The default number is 100 and is
changed at the request of a Customer Support representative.

Data Viewers: Selecting Save method selection on exit will cause each Data
Viewer to save whichever method was selected when the viewer is closed or
the Exit button clicked. The next time the viewer or CDS software is opened,
the saved method will be displayed. When Manually choose method before
viewer opening is selected, the user will be prompted to choose a method
before a data viewer is opened.

Automatic Database Backup: When enabled, the CDS database files will be
backed up to the selected location at the time of day entered. Should there be
a malfunction resulting in the corruption of the database, a Customer Support
representative may be able to retrieve the lost data from the backup copy. Each
backup replaces the previous one. Backup time depends on the size of the
database but usually does not take longer than 15 minutes.
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Security The security features allow for the creation of security profiles providing
different levels of access to various areas and functions of the CDS application.
Individual users can then be assigned to a security profile, and then choose
their own individual CDS log-on password. The system also has capabilities for
manual and automatic logoffs.

The security features should only be activated by the administrator of the
System; i.e. the person ultimately in charge of the CDS who will be creating the
security profiles and assigning users to them.

The security features can be activated by performing the following steps:

Check the box next to “Enable Security”.

2. After enabling security, the user also has the option of selecting an
inactivity interval after which the CDS will log off the current user.
Simply click on the “Log Off” box and use the up/down arrows to
choose the desired log off interval.

3. Click Accept at the bottom of the window.

4. A password dialog will then appear asking for a User Name and a
Password. Type the User Name of admin, and the password istat.
Then click on OK.

5. Another dialog box will appear prompting you to change your password.

6. Type in a New Password of your choosing in the space provided. Then
retype that same password on the New Password Verification line and
click OK. This will automatically bring you to the CDS application.

Rev. Date: 07/18/06 Art: 715021-00C
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INTERFACE PROGRAM CUSTOMIZATION

Overview

Procedure

Send Priority

Rev. Date: 07/18/06

The Central Data Station can output results to an external computer system
such as an LIS or HIS. The Central Data Station also provides a function that,
when enabled, will also transmit all of the Precision PCx results generated on
the i-STAT 1 Analyzer to QC Manager so they can be managed as part of the
overall Blood Glucose Testing program.

The Central Data Station needs to be customized for the interface type using
the procedures below. Tabs are presented for the options available. Each
tab represents a protocol that the Interface Component of the CDS supports.
Depending on the particular installation, one or more of these will be used.

Exit the CDS application. Access the Run dialog box by clicking Start
Run... Type c:\istat32\bin\interface32.exe at the Open: prompt, then
click OK. If Run... is not on the Start menu, double click the Command
Prompt shortcut. At the C:\> prompt in the window that opens, type
c:\istat32\bin\interface32.exe and press Enter. Click File &> Options. The
following screen will be displayed.

These tabs are used by the interface provider to configure the interface
Component of the CDS for the protocol that will be used.

STAT CDS Interface Option

This function will prioritize the queue of results in the CDS database being
processed by the Interface Component of the CDS program. This capability
can be used by the interface provider to prioritize handling of results from one
location over another.

Art: 715021-00C
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Procedure

The CDS program must be running and the external interface must be
enabled.

Double click the i-STAT interface icon in the system tray (next to the
clock in the lower right hand corner of the screen) to open the interface
program’s main screen.

Click File > Options...

Click the Send Priority tab. (The other tabs will be available for viewing
only.)

Click the Location/Method line to prioritize.

Right click under the Send Priority column and select the priority:
Normal, High, Very High, from the drop down list.

Click Accept to finish.

| Hormal
| Normal
Ve High
| Mormal

Morrnal

al
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OVERVIEW OF THE CENTRAL DATA STATION PROGRAM

Central Data
Station Software
Function Overview
and Toolbar
Buttons

Rev. Date: 07/18/06

The Central Data Station (CDS) software includes the following point-of-care
testing process management functions:

* Managing Instruments * Managing Analyzer
Customization Profiles
* Managing Operators ¢ Maintaining Database
Contents and Size
* Managing Inventory * Monitoring External
Interface Activities
* Managing Policy *  Monitoring Analyzer
Compliance Download Intervals
*  Monitoring Operator *  Managing LIS entry
Competence exceptions

* Reviewing Patient and
Quality Results

These functions are listed under the main menu option in four main groupings:
monitors, viewers, workspaces and reports.

sl Monitor

Download

) Interface
mg{ Administration Tools (Workspaces)

mw
TR
@

Instrument/Location

Operator

Database Maintenance
Inventory
Customization

User Administration

Data Viewer

Results (patient)
QC Codes
Simulator
Unsent Records
Control Results

Calibration Verification

Proficiency Tests

Report

Reagent Management

Method Competence

Method Compliance

Art: 715021-00C
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ADMINISTRATION TOOLS *=

Overview

Administration Tools include Workspaces for Instruments and Locations,
Operators, Database Maintenance, Inventory, Customization, and User
Administration.

i= |
INSTRUMENT AND LOCATION WORKSPACE r’if&it

Overview

Locations

Rev. Date: 07/18/06

This workspace is used to:

® assign names to download locations,
® assign instruments to locations,
® configure the reporting and monitoring options for each instrument, and

® set required download intervals for each location.

The following sequence of tasks is used to set up the Central Data Station’s
management function for instruments:

1. Assign Location Names to Location Codes. Location Codes are the
physical port addresses for the download devices.

2. Assign Instruments to Download Locations.

[l Edit Location Name

The location name can be changed from a letter/number code to the name of a
nursing unit, department, site, etc.. Up to 17 characters can be used to identify
a location. Click Location > Edit Location Name... in the menu or click Loc.
Name in the toolbar.

Note: Interface logic should be considered before editing.

( Add New Download Location Assignment

Download locations can be added manually. Click Location > Add Download
Location Assignment... in the menu or click the Add Assig. in the toolbar.
Download locations will also be added automatically when a transmission is
received from a download device with a location that is not already on the list.
The name assigned is A_xx, where xx is the download device’s IP address or
serial port. This name can be changed as described under Edit Download
Location Assignment.

To assign instruments to a location without a download device, enter a Location
Name or another descriptive word as the Location Code.

Art: 715021-00C
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Instruments

1 Delete Download Location Assignment

Click Location > Delete Download Location Assignment... from the menu or
click Delete Assig. in the toolbar.

] Edit Download Location Assignment

Click Location > Edit Download Location Assignment... from the menu or
click Edit Assig. in the toolbar.

Once physical download locations have been given location names, the
Instruments tab page will be the focus of management activities.

-j300088 &12272001 11:59:2 Assign)
300088 SMB2001 135526 Assignment

300098 SHEIZ001 13:5413 Asgignment

Lecation: Instruments are assigned to locations. This assignment is made

when an instrument is manually added in the Instruments page or when an
instrument downloads to the Central Data Station for the first time.

Method: The CDS is designed to accept results from any instrument that can
be downloaded to the CDS program. The i-STAT method in the Instrument
window refers to the i-STAT Portable Clinical Analyzer, the i-STAT 1 Analyzer
(both i-STAT cartridge and MediSense Precision PCx and PCx Plus Glucose Test
Strips) and the Philips Blood Analysis Module.

Clicking a Location/Method on the left side of the window will list the status of
all instruments for that location and method in the right side of the window. A <
symbol indicates which location and method has been selected.

Highlight Download Status: Checking this box will highlight locations with
instruments that have exceeded the required interval for downloading as well as
noncompliant instruments within the location selected.

(] Add Instrument

The Add instruments window is used to add an instrument to the system. Click
Instrument o> Add... from the menu or click Add Inst. in the toolbar. Select a
method from the drop down list.

Note: If using the i-STAT 1 Analyzer for cartridge and/or test strip runs, select
i-STAT as the method.
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Select a location from the dropdown list. If the location is not listed, add the
location using the instructions under Add New Download Location Assigment.
If the location does not have a download device associated with it, such as an
instrument used for transporting patients, a location name can be typed in. (In this
case the Location Code on the Locations tab page will be SYSCODExxxxxx.) Up
to 17 characters can be used.

There are two options for Download Result Reporting, both of which apply to the
i-STAT PCA, i-STAT 1 Analyzer, and the Philips Blood Analysis Module:

1.

Always report location as this assignment: The results from this
instrument will appear with the location of the instrument’s assignment
regardless of the download device used to transmit the results. This
option is useful when an instrument is assigned to a functional group
that may download from various areas in the institution. The instrument
will be designated “Assignment” under the Reports column in the
Instruments tab page.

Report location as download location: The results from this
instrument will appear with the location for the download device that
was used to transmit results to the Central Data Station. The instrument
will be designated “Download” under the Reports column on the
Instruments tab page.

If the instrument is not manually added to the list and it transmits to the
CDS, it is automatically assigned to the location of the download device
and is set to report “Download.” If the download device location has not
been manually added, a default location A_xx (B_xx, C_xx, etc.), where xx
is the IP address or serial port of the download device, will be used.

There are two options for Download monitoring:

1.

Include in download monitoring: Includes this Serial Number in
download monitoring.

Exclude download monitoring: The download status of the instrument
will not be reported by the Download Monitor. (Blood Analysis Modules
and infrequently used or spare analyzers might be exempted from the
Download Monitor report).

Art: 715021-00C
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[ Delete Instrument

Click the Location/Method for the instrument to be deleted and then the serial
number of the instrument to be deleted. Click Instrument > Delete... from the
menu or click Delete Inst. in the toolbar.

[ Move Instrument

Click the Location/Method for the instrument to be moved and then on the serial
number of the instrument to be moved. Click Instrument => Move... from the
menu or click Move Inst. in the toolbar. Select the new location from the drop
down list or type in a new location.

] Find Instrument

Click Instrument £ Find... from the menu or click Find... in the toolbar. Enter
the serial number of the instrument and select the Method from the drop down
list.

] Edit Instrument Comment

Click the instrument serial number, click Instrument > Edit Comment from the
menu or click Edit Inst. in the toolbar. Enter a comment of up to 16 characters.

[ Change Current Instrument Setttings

Reporting: Click the instrument serial number. Click Instrument > Current
Instrument > Change Reporting from the menu or click the down arrow next
to Current Inst. and then Reporting in the toolbar to toggle between Download
and Assignment.

In Use: Click the instrument serial number. Click Instrument > Current
Instrument > Toggle In Use from the menu or click the down arrow next to
Current Inst. and then In Use in the toolbar to check (in use) or un-check (out of
use) the analyzer in the In Use column.

Instruments that are not checked “In Use” do not have a download criteria
applied to them. You would use this for instruments you do not expect to be
downloaded. When an analyzer that is not marked “in use” downloads, it is set
back in use and the download criteria is applied.

Monitoring: Click the instrument serial number. Click Instrument > Current
Instrument > Change Monitoring from the menu or click the down arrow next
to Current Inst. and then Monitoring in the toolbar to check or un-check the
analyzer in the Monitoring column.

] Add Instrument Note

Click Instrument > Add Note... from the menu or click Add Note in the toolbar.
A note of up to 50 characters can be entered. The note will appear as a Log
Entry in the Instrument Log tab page.

(1 Change Download Monitoring Criteria

Compliance to download policy can be monitored by the CDS program. Click
on the Location/Method. Click on Instrument > Download Criteria... from the
menu or click Criteria in the toolbar. Enter the required download interval. An
interval of up to 1000 hours is allowed.

Compliance with the criteria can be observed by checking the Highlight
Download Status check box or by going to the Download Monitor. Individual
Download criteria can be set for each location and method pair.
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Note: The I-STAT 1 Analyzer can also be customized either to warn the end
users that a download is required or to lockout end users if the time for
a download has been reached or exceeded. The download criteria for
analyzers and for the CDS monitor should be selected to make sense.

1 Instrument and Location Summary

The Instrument and Location Summary provides a report of the current
instrument assignments and the last downioad for each instrument. Click Main
r.> Open Report > Instrument Summary from the menu or click the down
arrow next to Report and then Summary in the toolbar. Summaries can be
viewed and printed by:

* This method and location only (location and method selected with <
symbol)

* This method, all locations (method selected with €4 symbol)

¢ All methods, all locations

 Method LS TAT

iLocabon  I-ANTHES

[Genal Number [Last Download Jin Use JReperis [ Manitor | Cormment ]
303395 AN42003 07 2901 <4 Assignment N
303449 Download L

Location. 1-CVOR Method  STAT

[Eienial Nurnber

|Last Downiczd

JjrUse JFepons

302060 4/10/7003 08 3559 4 Dewnload

302628 B 22003171325 A Covmload ¥
303425 4122003 00.05 32 ¥ Download £
303538 1/9/2003 0837 15 ¥ Download ¥

[[(Monitor | Eornment
\j

Locabon:  1E-FACU

Method  FSTAT

[Eeral Nurmber

\Last Downicad

Jin Use ]Repons

[ Monitar | Eemment
4

303381 ABrz003 15:04:37 ¥ Download
Locaton  1E-FREOP Method:  -STAT
[Sierial Nurnber |Cast Cowniozd Jjn Use |Fepors [ Menitor | Eamment
303388 414/2003 11,4508 Y Download 4
Location  1-MPACL Method:  FSTAT
[Eerial Rumber |Last Downiozd |jn Use Repens [ Monier | Eomment ]
303416 41442003 D8 2737 +  Download N
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Instrument Log

The Instrument Log tracks all changes made in the Instruments tab page.

Additional comments can be added to the log by clicking Add Note in the
toolbar.

(1 Date Range...

Data can be viewed within a user defined default range or by a manually entered
range.

(] Delete...

The Delete button allows selected or all entries within the date range selected to
be deleted.

To print the log press the F2 key or select Print from the Main menu or toolbar.

02628 S 12Jun2003 1713

0262 12Jun2003 17.13 Instrument removed from use

02628 12Jun2003 17:13 Instrument sel lo report download location
302628 s 120un2003 1712 Imstrument set lo repor location essignmerl
DE80552851 19Mar2003 1415 Instrument added to locabon BE-CVICU
DEBOSS2548 19Mer2003 1308 Instrument added lo location 6E-CYICU
DESNSS 1568 19Mzr2003 1306 Instrument added to location BE-CVICU
DEBO550502 S 19Mar2002 1204 Instrurnent added to locabon BE-CVICL
DESUS50500 19Mar2003 13 02 Instrument added to locaton BE-CVICL
DET72850254 3 19Mar2003 1259 Instrurment added to lecation E-CVICU
1DEB0SE1563 19Mar2003 12.56 Instrument added lo locabon BE-CVICU
29611 04Marz003 14 30 Instrument deleted

23806 04Mar2003 1420 Instrurment deleted
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OPERATOR WORKSPACE T'F

Overview

Operators

Rev. Date: 07/18/06

This workspace is used to:
* Record operator names and identification numbers
* Record certification dates and certification expiration dates
* Assign operators to departments

e  Add comments

When the i-STAT 1 Analyzer is customized to use the operator list created here,
the analyzer can be customized to warn or lockout operators if they are not on
the list or their certification has expired.

Operators are listed by Department and Method as indicated by the <4 symbol.
Operators are added to the operator list by department and by method.

When a record is received with an Operator ID that is not listed in any
Department, the operator is placed in the “Unassigned” department.

b FETAT
Lab Frecision PCx
MursIng LSTAT 4
Mursing Precision PCx 3 S L
- LETAT Ann Huner AAW007 4097003
fUnassipned  +STAT Michel Clayion ANA00Z AN 2003
Jody Mason 41977002 A92003
Bill Stephiens 4192002 4187003
Cindy Dawvis A1972002 4182003
Sharon Miller 4119/2002 411812003
Julia Wayer 411672002 411812003
Cathy Burlon 411972002 41912003
RusselWaller 411972002 4182003
Jean Bemner AN92002 an 82003
Ann Baker 492002 482003 Super user
Heriry Folier 4n92002 aneiroo3

(L Operator list edit in progress

When editing the operator list, check this box to delay updating i-STAT 1
analyzers until all editing is complete. When editing is complete, click the
box to remove the checkmark. This box will appear when Serial or Network
Communications are enabled, Customization is enabled and Use Operator List
is enabled.
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[ Add Operator

This function is used to add new operators to the list of operators. Alternatively,
operator lists can be imported (see Operator List Import at the end of this
section). Click Operator o> Add... from menu or Click on Add in the toolbar.

Enter the ID number that the operator will enter into the analyzer on the Operator
ID line. If a different ID number is used to access the LIS, this number should
be recorded on the Alternate ID line. An Operator Name of up to 40 characters
can be entered. A comment of up to 16 character can be added. If operators are
to be certified for more than one method, such as for the i-STAT cartridge and
the PCx glucose test strip, certify each operator for one method and use the
Add Cert. toolbar button to certify all applicable operators at one time for the
method. To add the first operator to a department, type the department name
(up to 10 characters). Once a department has been added, it can be selected for
additional operators from the drop down menu.

Check the Clear Operator data when "Add and Remain Open" clicked box
to specify whether or not the operator information fields should be cleared when
the Add and Remain open button's clicked.

L] Delete Operator

Select the operator or operators. Click Operator > Delete... from the menu or
click Delete in the toolbar to delete the operator or operators. When the last
operator from a department is deleted, the department is removed from the
system.

1 Move Operator

Select the operator or operators. Click Operator > Move... from the menu or
click Move in the toolbar, and select a new department from the drop down list.
If the department is not in the list, type in the new department name.

(1 Find Operator

Click Operator > Find... from the menu or click Find in the toolbar, select the
method for which the operator is certified, and type in the operator ID. A box
will appear around the found operator.

[ Edit Operator Data

Click the operator. Click Operator > Edit from the menu or click Edit in the
toolbar. The operator ID, name, comment and alternate ID can be edited.
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(] Update Certifications

Select the operator or operators. Click Operator > Update Certification...

from the menu or click Update Cert. in the toolbar and complete the Update
Certification form.

(1 Add Certification

The Add Certification button allows operators who are certified for one
method to be certified for another method without having to complete a new
Add Operator form. Highlight the operator or operators in the Operator tab
window that are to be certified for another method. Click Operator > Add
Certification... from the menu or click the Add Cert. button on the toolbar.
Select the other method for which these operators are to be certified, then
specify the certification dates.

+ Tipetato: Work e} taladd Certification

Freisien Pon
FSTAT 1
Frecision P
+STAT

RETAT

(] Add Note

Click the operator. Click Operator > Add Note... from the menu or click Add
Note in the toolbar. An Operator Log Note of up to 50 characters can be typed.

Art: 715021-00C
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[ Edit Department Name

Click the department name to edit. Click Operator > Edit Department Name
from the menu or click Dept. Name in the toolbar. The Unassigned designation
cannot be changed.

[l Operator and Certification Reports

Click on the down arrow next to Report in the Operator Workspace toolbar and
click on Summary or Expiration.

Operator Summary: Summaries of operators can be viewed and printed by:

e This method and department only (department and method selected
with €4 symbol)

* This method, all departments (method selected with €4 symbol)
* All methods, all departments

The reports include operator 1Ds, operator names, certified from date,
certified until date, comments, a checkmark if certification has expired
and the operator’s alternate IDs grouped by department and method.

Operator Certification Expiration: This report allows the certification status of
operators to be viewed.

03/29r2004
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Operator Log
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The Operator Log tracks changes made and “Add Note” entries made in the
Operator tab page. The Date Range... button can be used to specify a time
period to be viewed and the Delete... button to delete entries. To print the log
press the F2 key or select Print from the Main menu.

Ej

Jose-Time
52242008 14:31:23
-STAT 5{22/200614:31.15
-STAT S22/2006 14:31.03
FETAT 512202006 143041
35 -ETAT 5i22/2008 143023
1204 -STAT §/22/2006 14:30:23

Hi221200614:30:02
812242006 14:25:52
S/22/2008 14.29:24
5i22/2006 142913
512242008 14:2%.04

04500804 -BTAT 512242006 14:28:24

Cedification set from 51222006 to 10/222006
Cerification set from 5122020086 to 5/22/2007
Cedification setfrom 512202006 to 1/22/2007
Certification setfrom SI22/2006 to 172212007
Cerlification set from 52242006 to 1142272006
Cerlification sel fram 52242006 {0 11/22/2006
Operator moved from Unassigned to Laboratory
Operator moved from Unassigned to CCU
Operator moved from Unassigned to Laboratory
Operator moved from Unassigned fo CCU
Operator moved from Unassigned to CCLU
Operatar moved from Unassianed to Laboratory
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OPERATOR LIST IMPORT

This function in the Operator Workspace on the CDS5 allows an operator
list to be imported from a text file. To access this function, click on Main >
Open Administration Function r}» Operator from the main menu to open the
Operator Workspace. Select Operator > Import List... from the main menu
to open the Import Operator List window. This window is used to describe the
format of the text file containing the list to be imported into the CDS.

Dperator 10 SkinFieis(2)
rlame
FCorment SHpF ey
Mternate ID SkKgFiaid(s)
{Hethod

Ceifiad rom
feertifiad unts

Shpfiaig(

Import List 1.

Instructions

Rev. Date: 07/18/06

Under Fields in text file:, use the mouse to drag and drop the field
names so they match the order in which the fields appear in the text file
containing the list to be imported. If a field does not appear in the text
file, drag it to the Available fields: list. If the text file contains a field that
should be ignored, drag a SkipField(x) field to the Fields in text file: list
to mark where that field appears.

Fields in the text file containing the list to be imported must be separated
by a comma or other delimiter character. Specify the separator in the
Delimiter character box.

If a qualifier character is used to enclose the data contained in each
the field in the text file containing the list to be imported, select this
character from the Text qualifier: list.

If the first line of the text file is a header line listing the names of the
fields in the text file containing the list to be imported, click Skip first
line of file (file contains headers). The import function cannot process
header lines.

If all operators in the text file containing the list to be imported are
to be certified for one method, click Assume a test method for all
operators and select i-STAT for cartridge testing or Precision PCx for
the MediSense Precision PCx or PCx Plus Glucose Strip testing on the
i-STAT1 Analyzer. If this option is selected, the text file does not need to
contain a Method field. If this option is selected and the text file does
contain a Method field, its contents will be ignored

If all operators will be certified from the same date, click on Assume a
certification start date for all operators and enter the start date. |If
this option is selected, the text file does not need to contain a Certified
from field. If this option is selected and the text file does contain a
Certified from field, its contents will be ignored.

Art: 715021-00C
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If all operators are to be assigned to the same department, such as
Nursing or Perfusion, click on Assume a single department for all
operators and enter or select the department from the drop down
list. If this option is selected, the text file does not need to contain a
Department field. If this option is selected and the text file does contain
a Department field, its contents will be ignored

Example from list to be imported:

“ICU”, 123457, “Smith, Judy”, “none”, “98765", “i-STAT”, “2001-08-08",
“2002-08-08"

Click Select File... and select the name of text file containing the list to
be imported.

Click Import File to import the list from the text file.

Note: operator data that already exits in the CDS5 database takes

precedence over any data imported from a text file.

Export List After a list has been imported or created, it can be exported for backup
purposes.

18-32

Art: 715021-00C Rev. Date: 07/18/06



DATABASE MAINTENANCE

Overview

Archive Test
Resuits

Rev. Date: 07/18/06

This workspace allows the database to be backed up, deleted and restored. A
"Statistics" tab page also allows users to view a summary page of Result Types
contained in the database.

Backup test results: This function allows test results to be backed up onto a
disk, CD or other directory. (Note: a 1.44MB disk will only store about 1000 test
records.)

1. Click on Main > Open Administration Functions > Database
Maintenance.

2. Atfter the workspace opens, click the Archive Test Results tab.

At Test Resiits |Gatabace Fils | Stapstics

Funciopi e s
f-‘l?.‘am:kuphasuesuﬁ,t

i Pestte jest resuits ot

P s BV R S A L

Stnbete - [ounyaooa

Endoze - [GE0Z08 T e
O Backp : : S Selesrtactmetiodisy Skt achive Tele)
# Backup 2nd Delete 3

© O Delete only

-Dielete options -

* Delete details datasnty -

~ Deite détais nd Oermbbiedatn. | & Selectoll isthos

Paekiip and Defetg

Click the Backup test results radio button.
Specify a date range for the function.

Select a Backup Option: Backup, Backup and Delete, or Delete only.

o o s w

If an option that includes Delete is selected, then select a Delete Option:
Delete details data only or Delete details and demographic data. Details
data includes:

* QOriginal Operator and Patient 1D
s Patient Name

¢ LIS order number

¢ Sent status

*  Analyte values

e Extradata

Demographic data can be used to generate reports. Demographic data
includes:

¢ Test type (test result, simulator, proficiency,...)
s Test panel (such as EC8*, CG8*, PCx Glucose)
» Test Method (i-STAT, Precision PCx...)

e Patient ID

e Operator ID

e Test date/time

Art: 715021-00C
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* Location
e Comment
* Interface comment
e Serial number
e Department
7. Select a Directory.

8. Select a method or methods to back up or click Select all methods.

9. Click the button marked Backup or Backup and Delete and follow the
prompts.

Note: When results are being deleted as part of a backup and delete or a delete
only operation, the deletion can be cancelled. Simply click on the Cancel
button to stop the operation. Once the Cancel button is clicked, depending on
the amount of data being deleted and the size of the database, there may be a
significant lag time of a few minutes before a dialog box appears indicating that
the deletion has been paused, asking you to select one of three options:

The reason for the lag time is that the program needs to complete whatever
portion of the deletion operation it was performing when the Cancel button was
clicked before it can display the dialog box. Once the dialog box is displayed,
simply click on the desired radio button and then click OK.
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Database File

Statistics

Rev. Date: 07/18/06

Restore test results: This function allows test results that have been deleted
from the CDS but backed up elsewhere to be restored to the database.

1. Click on Main &> Open Administration Functions = Database
Maintenance.

Insert disk or CD where files are located.
Click the Restore test results radio button.
Select the directory for the stored results.

Select the method or methods to be restored.

Z o oy By

Select a restore option: Restore demographic data only or Restore
demographic and details data. (Demographic data can be used to
generate reports.)

~

Select the files to be restored or select all files.
Click the Restore button.

Backup Database File: This function allows the user to manually perform
the same operation that occurs when the automatic database backup occurs. It
creates a complete backup of the database file to the specified drive/directory.

Compact Database File: When the backup and delete or delete only functions
are executed, the deleted data is removed from the database but the disk space
the data occupied in the database file is not. The compaction function creates

a new copy of the database with the excess space removed, creating a smaller,
better organized and, therefore, more responsive database. If CDS functions

such as opening or refreshing a data viewer grow noticeably less responsive over
time, compaction of the database may help. It is recommended that compaction
function be executed at least once a year.

A “Statistics” tab page allows users to view a summary page that lists:

The total results in the database,
The date and time of the oldest result in the database,
The date and time of the newest result in the database, and

il

A breakdown of the total results in the database by Result Type and
Method.

Electronic Simuletor

Cuahty Check Code FSTAT
ntrol Result =STAT
Cal’Ver Result -STAT
Frofciency Result 1STAT
Test Result Precision PCx
CQuality Check Code Frecision PCx
Control Result Frecision PCx

Art: 715021-00C 18-35



18-36

Selecting an individual Result Type and then clicking on Details allows you to
view a similar statistical breakdown for that particular Result Type:

(OIS ek

The total number of that particular Result Type in the database,
The date and time of the oldest result of that type in the database,
The date and time of the newest result of that type in the database,

A breakdown of the number of this particular result type that have been
sent successfully (Yes), unsuccessfully, or not sent at all (No) to the
LIS/HIS. Note: a listing in this window for “Not Available” indicates
that there are records of this type in the database where the details data
have been deleted, so the application cannot determine whether that
particular record was sent or not.

Mot Ava‘rlable ‘

MNo
Unsuccessful
Yes
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INVENTORY WORKSPACE

Overview

Items

Rev. Date: 07/18/06

The Inventory Workspace is organized under five tabs with the following functions:

e Stock: define reorder triggers, view and edit inventory

e Distribution: track items distributed from central stock to different
locations

e Orders: track pending and received orders, view reports on received
items

e ltems: define inventory items
e Inventory log: view a log of major user actions

Populate the ltemns tab first, followed by the Stock tab where current inventory
should be entered and reorder triggers defined.

The ltems tab is used to define the inventory items for the i-STAT System and
other point-of-care tests.

To select an item available from i-STAT and its distributors, highlight the item in
the Choose items from the list on the right side of the window, then click the

arrow next to the Add button in the tool bar and click the Selected button. The
item will move to the Available items list on the left side of the window.

To add an item not available from i-STAT and its distributors, click the arrow next
to the Add button in the tool bar, then click the New button and complete the
displayed information form.

+ -
-STAT 6+ carlridge 0BFO5-01  Abbott
9V Lithiurn Batleries 06F21-26  Abbott

EC4+ FSTAT EC4+ carridge
ECE+ FSTAT ECB+ cartridge

I-STAT CalVer Set 0BF15-01  Abbott ECB+ FSTAT EC8+ cartridge
-STAT G3+ cartridge DBFO2-01  Abbott EG4+ FSTAT EGE+ cartndge
I-STAT Level 1 Cantrol O6F12-01  Abbott EG7+ FSTAT EG7+ carridge
FSTAT Level 3 Control DBF14-01  Abbott G FSTAT G carfridge

MeterTrax, High 310-H

eterTras, Low

Hematronics
Hematronics

HP Pt Paper  Paper for HP Printer
Level 2 Control  FSTAT Level 2 Centrol
MeterTrax, All - MeterTrax, All
MeterTrax, Med MeterTrax, Medium

PT FSTAT PT cartridge

PT Lev. 1 Contr. -STAT PT Level 1 Contro
PT Lev, 2 Contr. +STAT PT Level 2 Contro
Setko Pt Papel Paper for Seiko Frinter

erTray, Low

To delete an item from the Available items list, highlight the item, then click the
Delete button in the tool bar. If the item was selected from Chose items from
the list, the item will be moved from Available items back to this list.

To edit information under the Available items list, click the Edit button in the tool
bar.
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Stock

Startup Option

S

The Stock tab includes both Inventory and Estimated Inventory statistics.

Inventory: The number of given items as counted and entered by the user. The
inventory is automatically updated when new orders are received under the Orders
tab.

Estimated Inventory: The number of i-STAT cartridges and MediSense PCx
and/or PCx Plus glucose test strips as estimated by the workspace software.

The initial Estimated Inventory is taken from the Inventory column. Every time

a cartridge or glucose test strip result is transmitted to the Central Data Station
software, the count of the estimated inventory decreases by 1. The Estimated
Inventory is automatically updated when new orders are received under the
Orders tab. The Estimated Inventory item count is adjusted to the Inventory count
whenever the Inventory column is manually edited.

The items added under the Items tab will be listed under the Stock tab with
Inventory and Reorder set to 0. There are two ways to populate the Inventory
column.

1. Count current stock. Go to the Stock tab, click on the Edit button in the
tool bar, and enter the current inventory. Lot numbers and Expiration
dates will not be tracked for inventory entered by this method.

2 Count current stock along with lot numbers, expiration dates and loca-
tions. Go to the Order tab and enter and receive the POs for the exist-
ing stock. Go to the Stock tab and manually adjust the Inventory to the
current stock count. (Alternatively, receive only the current stock count.)
This option allows the user to take advantage of the lot number and expi-
ration date tracking capabilities of the workspace.

Click on the Edit button on the tool bar and enter the reorder trigger numbers.

Click a check mark next to Highlight items to be reordered. Items that need to
be reordered will be highlighted. (See CalVer Set in illustration below.) Reorders
are highlighted based on the Estimated Inventory.

ETAT B radridge

¥ Lithium Batieries 52
Hia- FSTAT Caltver Set 3 NZI006151918 3

BTAT 23+ carridge 250 WI220061571808 25
HP Pmt Papet Paperfor HP Frinter 5 222006151812 &
Level 1 Conlrol FETAT Level 1 Control 227006151847

FSTAT Level 3 Control 2 &2 B161623 2

The inventory can be edited by highlighting the item and clicking the Edit
button or by clicking the Adjust Invent button, selecting the item from the drop
down menu, and adding or subtracting units. When the Inventory is edited, the
Estimated Inventory is automatically made equal to the Inventory.
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Orders
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The Estimated Inventory for i-STAT cartridges and MediSense PCx glucose

test strips will automatically begin updating with the next analyzer transmission.
Click the Refresh button to update the workspace for transmitted data. Both the
Inventory and the Estimated Inventory are updated automatically when orders
are received under the Orders tab.

Periodically, the Estimated Inventory should be updated manually. This is
necessary to account for other consumables as well as for cartridges and strips
that are discarded before testing, such as expired inventory. Click the Estim.
Invent. button in the tool bar to adjust the Estimated Inventory.

To record a new order, click on the Add button in the tool bar.  Select the item
from the drop down menu under Item and enter the quantity. Click the Add ltem
button to add another item or the Delete ltem button to delete an item.

To enter information about a received order right away, click on the Receive
Order button. To enter information about a received order later, click the Order
Pending button.

To receive an item or to edit order information, click the Edit/Receive button in
the tool bar. Highlight the PO Number and enter the Order Details.

Note: The lot number and expiration date are used in the Distribution
tab. Therefore, PO, lot number and expiration date information for
consumables in inventory should be entered here. The PO number
field can accommodate up to 20 characters.
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Click the Add Button to add another item or the Delete Button to delete an item.
Click the Receive All Button to automatically enter items and quantities, as they
were ordered.

00E 250 ADBOT4

Use the Delete button on the tool bar to delete an order.

Use the Find Lot and Find Next buttons on the tool bar to find the PO associated
with a received lot.

Use the Delete Lot button on the tool bar to delete a lot number that has expired
or has been used up.

The Report butten on the tool bar is used to view all received items by date
range.

Use the Add Note button on the tool bar to add a note to the Inventory Log.
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Distribution

Rev. Date: 07/18/06

Use the Add button in the tool bar to record the distribution of consumables. The
Item drop down menu includes all consumables entered in the Items tab. The
Location drop down menu includes all locations entered in the Instrument and
Location Workspace. The Lot Number drop down menu includes lot numbers

for the selected items received in the Order tab. The expiration date is entered
automatically. A comment of up to 16 characters can be entered.

[Aosn7e -1

THFEIFE

The Distribution tab will list each location with its consumables. Define an alert
date and click a check mark next to Highlight items expiring within xx days to
alert you to transfer stock to a different location where it can be used before its
expiration date.

Use the Delete button on the tool bar to delete a distribution.

Use the Transfer button in the toolbar to move consumables from one location to
another.

Use the Find Lot button to find a location where a consumable of a specific lot has
been distributed. Click the Find Next button to find other locations for this lot.

Use the Add Note button to add a note to the Inventory Log.
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Inventory Log

The Inventory Log documents each action taken in the ltems, Stock, Distribution
and Orders tabs. Click the Date Range button in the toolbar to select the a
Default date range or a Start and End date for this report. Click the Delete button
to delete entries in the log.

§/23/2006 10:3016
5i23i2006 10:25:36
S/237200610:21.22
612312006 10:21:10
5i23/2006 10:20:36
SI23/2006 09:55:20
SI2312006 09:54.18
5I2212006 15:19:16
5I22i2006 15:18:38
S22700615.18:28
51222008 15:18:23
51222006 151817
SI22/2006 151812
51222006 15:18:08
5222006 151802
SI2U2006 151755

175 B+ lems dislributed 1o A_1 localion
Recened information for order ‘34567 8" edited
Order 345768 deleled.

Received Infarmation for order ‘245678 edited
Order ‘345678 received

Order 345678 added

Order 3457 68" added

Irventory for CaliVer Set adjusted from 0o 3
Irventory for MeterTrax, Low adjusted from 010 5
Irventory for MeterTrax, High adjusted frorn 0 to 5.
Inventory for Level 3 Conlrol adiusted from 0 lo 20,
Inventory for Level 1 Control adjusted from 0 1o 10
Inventory for HP Prnt Paper adjusted from 0 to 5.
Inventory for G3+ adjusted frorm 0 lo 2500
Ireentory for Batteries adjusted frorm O fo 10,
Irentory for 6+ adjusted from 0 1o 1000
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CUSTOMIZATION WORKSPACE ﬁ

Overview

Password

Enabling
Customization

Rev. Date: 07/18/06

This workspace is used to create profiles with site specific test characteristics
for the analyzers. See the Customization section of this manual for details of
items that can be customized and their default settings.

The Customization Workspace is password protected. If the Security feature is
disabled, the default password is istat. If the Security feature is enabled, the
user uses the same password as their CDS application logon password. To
change the password, select Tools and Change Password from the menu bar.
A password from 3 to 8 characters can be used.

To enable customization, click the box to check it. When customization is
enabled, the Central Data Station will check the Customization Profile for
the location each time an analyzer is downloaded. If the location has the
Enable Updates option checked, the Central Data Station will update the
analyzer with the current Customization Profile for that location as noted below.

® Analyzers designated to Report location as download location in the
Instrument workspace will be updated with the Customization Profile
assigned to the download location, regardless of the location to which
the instrument is assigned. Care should be taken when downloading
instruments from locations other then their assigned location.

® Analyzers designated to Always report location as this assignment in the
Instrument workspace will always be updated with the Customization
Profile for the instrument’s assigned location, regardless of the physical
location from which it downloads.

Pre

DEFAULTO

ChidPagse

CHART .

If a location has the Enable Updates option unchecked, downloading
from that location will result in no customization changes being made to
analyzers designated to Report location as download location. Analyzers
designated to Always report location as this assignment will not be updated
if the assignment location for the instrument has the Enable Updates option
unchecked, regardless of the setting associated with the physical location from
which it downloads.

User can also disable/enable CLEW updates by location. The default setting is
to have the CLEW updates occur automatically for all locations. To disable a
particular location, simply click on the corresponding check box under Update
CLEW to remove the check mark.

Art: 715021-00C

18-43



Default
Customization
Profile

Location-based
Customization
Profiles

The first step in customization is to create a default customization profile. This is
the profile initially assigned to every new location. To change the default profile,
use the directions under Making Selections or click the menu option Profile =
Change Default and the item to be changed. The changes in the default profile
are automatically applied to every location using the default profile.

Different customization profiles can be created for different locations. Uncheck
the Use Default Profile box for the location and double click i-STAT Analyzer
CLEW or BAM CLEW to change the CLEW or double click Preferences to
change any of the preferences. Alternately, select the menu option Profile
» Change Location-Based and the item to be changed. Changes in the
customization profile can be made for several locations at once by selecting the
locations and then selecting the appropriate option from the Profile Menu. If a
location has the Use Default Profile option checked, its customization settings
will not be changed even if it is selected. Note that Language and the Unit Set
from the default customization profile are always used.
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Making Selections

Language Window

Rev. Date: 07/18/06

Preferences for locations can also be changed by selecting an existing
preference from the Apply Preferences submenu. Select the location or
locations to be changed. Click Profile > Apply Preferences. Select the
desired preferences and click Apply. Click View Preferences to review a set of
preferences.

Z8180RE
12B15WDE

Selections are made from options in the following ways:

* Select one of the seven main Customization options by double clicking
the box for Language, Unit Set, i-STAT Analyzer CLEW, Philips BAM
CLEW, i-STAT 1 Software, Preferences, or Chart Pages.

e After making a selection in the Language, Unit Set and CLEW window,
click the OK button to save the selection or click the Cancel button to
return to the previous selection.

Note: Russian is available only on the i-STAT Portable Clinical Analyzer and
Portuguese, Danish, and Finnish are available only on the i-STAT 1
Analyzer.
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Unit Set Window Details of each unit set are displayed under the Analytes column. Details are
also listed in the Customization section in this manual.

UMNITSETO mmoliL
UMNITSETOZ2 mmolil
UNITSETO3 mmolL
UNITSETO4 Mg/t
il
UNITSETOS ML
UNITSETDE mimolil
UNITSETO7 rrrnolil
UMITSETDS BPCY
NunTsETOS m?_fLL”L
UNITSET10
UNITSET11 : ik
UNITSET12 : mmHa
UNITSET13 mrmolil
unmsET14 i

UNITSET15 mn;;m'

_ |UNITSET16 ACTWBT seE
UMITSETSY : aFTT sec

To create a unique unit set, click UNITSET99 and then the User Settings tab.
Then select the name and units for each analyte or test.

Unis
mrnolil
mrnoliL
mrmoliL
mofdl
mofdL
mgidL
mmolil
AnGap mrnolil
Het WPCY
Hhb gidL
iCa mmaolil
£H
PCO2 mmHg
P22 mmHg
HCO3 mmaoliL
TCO2 mmuoliL
BE mmuoliL
502 %
ACTWET sec
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i-STAT Analyzer
and Philips BAM
CLEW Windows

i-STAT 1 Software
Window

Rev. Date: 07/18/06

i

62142006

A new CLEW is added to the window via the software update process twice a
year. If the Update CLEWSs feature is active, the Default customization profile
must be updated after each new CLEW is added. Click the new CLEW and click
OK. Note that there are separate CLEWs for the i-STAT analyzer and the Philips
Blood Analysis Module.

Note: Before changing to a new CLEW ensure that all analyzers have been
updated to a compatible application software version.

A new JAMS application software is added to the window via the software
update process twice a year. Click the new JAMS and click OK. Selecting the
new JAMS aloows users the option of updating their i-STAT 1 analyzers remotely
or locally using the Customization Workspace. Please see the Technical Bulletin
"Updating Analyzer Software" for full details on performing this procedure.
Checking "Disable Software Updates" disables this feature.

JAMS120D.BIN
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Preferences
Window

For detailed descriptions of the preferences, see section 9, Customization. The
Preferences Window has seven tab pages. Click the tab to display the desired
page. The following conventions are used in the Preferences pages:

¢ Enable/disable an option by clicking the check box to check/uncheck it.

e Change a numeric setting by clicking and holding the 4 or v symbol or
manually entering the number.

e Select an option from a list by clicking the v, and selecting the option
from the list.

* Select from multiple options by clicking the radio button next to the
desired option.

¢ Enter values into fields, such as for Reference Ranges and Strip Lot
Numbers.

When all information has been entered, a button is pressed:
e Default Values will restore the default settings to the open window.
*  OK will store the new settings.
* Cancel will ignore any new settings and restore the current settings.

Each Customization Profile is assigned a unigue name by the CDS program. This
name appears under the Preferences column in the Customization Workspace
window, on the Customization screen on the i-STAT 1 Analyzer, on the Analyzer
Status screen on the i-STAT Portable Clinical Analyzer and on the Blood Analysis
Setup screen of the Blood Analysis Module.

A description can be associated with a profile using the Description field in the
Preferences Window.

Caution: Close the Customization Workspace when finished to prevent
inadvertent changes.
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Chart Page
Selection Box

Backup and
Restore Profile

Rev. Date: 07/18/06

The Chart Page selection box is part of a feature allowing users to customize the
Chart Page on their i-STAT 1 analyzers in order to capture user-defined information
such as ventillator settings. See the "i-STAT 1 Analyzer Chart Page Customization"
Technical Bulletin for full details.

The current customization profile can be stored by selecting Profile <> Backup...
from the menu bar or by clicking the Backup toolbar button, selecting the directory
where the profile is to be stored, typing in a file name for the profile, and clicking
the Save button.
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To restore a profile to the CDS, click Profile 2> Restore... or the Restore toolbar
button. Select the directory and backup file to restore and click the Open button.

Backup Fies [*ACP)
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USER ADMINISTRATION WORKSPACE %

Overview

Access

Creating Security
Profiles

Rev. Date: 07/18/06

The User Administration Workspace is designed as a tool for system
administraters. It allows administrators to manage security profiles (a set
of security settings determining the access to different CDS screens and
functions), manage users, and assign users to security profiles.

Only users designated as administrators can access the User Administration
Workspace in the CDS by clicking on Main ;> Open Administration Function
> User Administration. A Password dialog will then appear. Type in your CDS
log-in password and click on OK.
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Once the User Administration Workspace is activated, the Administrator will
need to determine how many different security profiles are needed for their
facility, and what workspaces and functions should be available to users at
those different security levels. Once those decisions have been made, the
next step is to create the desired security profiles in the User Administration
Workspace.

Please note that an Administrator profile will always exist in the User
Administration Workspace. It cannot be edited or deleted, and allows access
for those designated users to all CDS Workspaces and functions.

To create a new security profile: click on Profile > Add... An “Add Security
Profile” dialog will then appear.

Agcess io the operalor workspace
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Deleting Security
Profiles

Editing Security
Profiles

Adding Users

Deleting a User

Assigning a User
to a Different
Profile

Type in the name of the new Security Profile, then check off the different
workspaces and functions users assigned to that security level will be aliowed to
access, and then click OK. The newly created security profile will then be added
to the Available Security Profile list.

To delete an existing Security Profile, click on the profile you want to delete in
the Available Security Profiles window. Click on Profile > Delete, and answer
*¥Yes” to the confirmation message that appears on the screen.

Please note that a Security Profile can only be deleted if all of the Users
assigned to that particular profile have first been deleted from the Users window.
If all of the users have not first been deleted, “Error Accessing Database” and
“Error Deleting Profile” messages will appear.

The Administrator Security Profile is permanent and cannot be deleted.

To edit an existing Security Profile, click on the profile you want to edit in the
Available Security Profiles window. Click on Profile > Edit. The name of the
profile will then be highlighted in blue. If you wish to edit the profile name,
simply type in the new profile name. Then select or deselect the desired listings
under the “Security Options for Selected Profile” window by clicking on the
corresponding check box.

When all edits are complete, simply click on Profile 3> Edit, and answer Yes to
the confirmation message that appears about saving the new changes.

Once all the Security Profiles have been created, the next step is to create users
and assign them to the various security profile levels.

To add a user to a security profile when in the User Administration Workspace,
click on User > Add.... An Add User box will then appear on the screen.

Type in the User Name in the first line, then choose the appropriate Security
Profile from the drop down list and click OK. The new user listing will then
appear in the User window.

To delete a user, select the user to be deleted, click on User > Delete, and
answer Yes to the confirmation message. Note: the user who is currently
logged on cannot be deleted.

To assign an existing user to a different Security Profile, click on User > Assign
Profile. A drop down menu will appear next to the user’s name. Simply click on
the desired Security Profile, then click on User > Assign Profile, and answer
Yes to the confirmation message that appears asking if you want to save
changes.
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User Log

The User Log tracks the following user activities: CDS Startup and Shutdown,
User Logon, Manual and Automatic User Logoff, and Disabling of the Security
feature via the Customization Screen.
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PASSWORD MANAGEMENT

Passwords

Emergency
Passwords

Rev. Date: 07/18/06

Once all the Security Profiles are created, and all CDS users are assigned to
the appropriate Profiles, the Administrator should provide the users with their
assigned User Names. Their initial password is istat.

When a user logs on to the CDS application for the first time, a dialog box
asking for a User Name and Password will appear. They should input their
assigned User Name supplied by the Administrator, and the password istat. A
dialog will then appear indicating that they must change their password. After
clicking on OK, the following dialog will appear:

The user should type in a unique password of their choosing in the space
provided, then retype that same password on the New Password Verification line
and click OK. The password must have a minimum length of 3 alphanumeric
characters, and a maximum length of 12 alphanumeric characters.

Once the password is changed, the user will then use their new password for all
subsequent CDS log-ons.

If a user forgets their User Name or Password, they have two options for
accessing the CDS application:

1. If available, the Administrator can log onto the User Administration
Workspace and look up the User Name from the User Window. An
Emergency Password for this particular user can then be obtained by
performing the following:
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Changing a
Password

SYSTEM LOGOFFS

a. Click and highlight this particular user’s listing in the User Window.

b. Click on User > Emergency Password. A box will appear with
an Emergency Password that this particular user can use. Note:
Once this user uses the Emergency Password to log in, they will be
immediately prompted to change their password for future CDS log-
ins. They cannot continue to use the Emergency Password for log-in
purposes.

2. If the Administrator is not available, the user can contact their local
Support Representative for an emergency User Name and/or password.
As with option 1 above, once this user uses the Emergency Password
to log in, they will be immediately prompted to change their password
for future CDS log-ins. They cannot continue to use the Emergency
Password for log-in purposes.

If a user is logged on to the CDS application, they can choose to change their
password at any time by clicking on Tools > Change Password. A dialog
box will appear asking them to enter their Old Password, as well as their New
Password (twice). After entering this information, the user clicks on OK and
answers Yes to the question that appears asking if they really want to change
password.

Overview

Manual Logoff

Automatic Logoff

The CDS provides the capability for manual and automatic user logoffs.
In the logged off state, the majority of CDS screens and functions are not
available. However, analyzer and BAM data can continue to be transmitted to
the application, and subsequently sent to the LIS/HIS (if applicable). Also, the
meonitors remain open if they were open prior to logoff.

Once a user has completed their CDS tasks, they can log off by clicking on

System > Log Off. A box will then appear on the screen indicating that the
current user has logged off.

Automatic logoffs are optional and can be enabled in the i-STAT CDS
Customization screen, as described in the Security section above on page 22-
13.
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Overview

Information in
Data Viewers

Rev. Date: 07/18/06

Data from instruments downloaded to the CDS are viewed in the Data Viewers.

Data downloaded from the i-STAT 1 Analyzers can be viewed in separate Data
Viewers for Results, QC Codes, Simulator, Unsent Results, Control Results,
Calibration Verification (or Linearity) Results and Proficiency Results (external
quality control).

Control, Calibration Verification and Proficiency Results from the Portable
Clinical Analyzers and Blood Analysis Modules will appear in the Results Data
Viewer.

Data from the Medisense Precision PCx Plus Glucose Test Strips can now be
viewed in the Data Viewers, alongside the data from the Precision PCx strip.
To determine which strip type was used on a particular testing run, look at the
column entitled Panel. Precision PCx Plus strip runs will be labeled PCx Plus
Glucose, while Precision PCx strip runs will be labeled PCx Glucose.

Data for only one method at a time, such as the i-STAT cartridges, is displayed
in a viewer. To switch to a different method, select the method from the
selection list in the lower left corner of the viewer. The exception is the Unsent
Results Data Viewer which displays results from all methods. Records are listed
based on which column is being sorted. Data can be displayed in ascending or
descending order by clicking a column as described above.

Example: Results Data Viewer
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Refreshing the
Data

Viewing Details

Customizing the
Data Viewers

Data is received continuously by the CDS. Updating the viewers with the
continuous incoming stream of data would make viewing the data difficult.
Therefore, new data is not added to a viewer until the Refresh button is pressed.
The window can also be refreshed by pressing F5 or selecting Refresh from the
Window option menu on the menu bar. The date and time of the latest refresh
are listed on the bottom right of the window.

The details of records in the Results, Control, Cal/Ver, Proficiency and Unsent
Results Viewers can be viewed by double clicking the record, by selecting the
record and clicking the Details toolbar button, or by selecting Record 2> View
Details... from the Menu.

Many of the Extra Data details may be helpful to the Customer Support
representative in troubleshooting.

Example of Details for Results Viewer

The viewers can be customized for individual preferences. The following
aspects of the viewers are user configurable.

[ Selecting a Date Range

The initial default date range for data in a viewer is the current date and back 7
days. The initial default range can be changed by selecting Tools > Customize
Viewer > Date Range... from the text menu, or by clicking the arrow next to the
Customize toolbar button, then the Date Range button. A default date range can
be set but overridden by entering a different date range for display. The maximum
default date range allowed is 999 days.
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The selection of a shorter date range enhances the system performance by
limiting the amount of information needing to be presented. It is always possible
to expand the range to view results from earlier and then reset to a more limited
default period. The date range function only limits what is presented, not what
is in the database.

(1 Selecting Columns to View

Columns can be hidden. Select Tools > Customize Viewer > Display Columns
or click the arrow next to the Customize toolbar button, then the Columns button.
To hide a column, click the box following the column’s name to uncheck it and
then click OK. To make the column visible again, click the empty box following the
column’s name to check it and click the OK button.

The Raw Location and the Receive Date/Time columns allow users to track the
location where particular analyzers are being downloaded, plus the time intervals
in which users are transmitting data to the Central Data Station.

[ Sorting Data

For customers who want to sort data in the Data Viewers by multiple column
criteria, a new multilevel sorting feature has been added. To access this feature,

open the desired Data Viewer, click on Tools > Customize Viewer 2> Sort..., or
click the arrow next to the Customize toolbar button, then the Sort button.

Date - Time

Interface Comment

Location
Operator Id
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Editing a Record

Finding a Record

A two-sided Sort dialog will then appear, listing Columns Available for Sorting
on the left, and Sort Columns on the right. Simply click the listing under
Columns Available for Sorting that you wish to sort your data by, and then
drag that column title to the right hand side of the screen under the Sort
Columns section. Once all of the columns you wish to sort by are under the
Sort Columns section, check whether you want that particular column to be
sorted by ascending or descending order, by placing or removing the check
mark in the Ascending box.

Once all selections have been made, simply click on OK and the sort process
will be completed, taking you back to the Data Viewer screen.

Note: By default, the Date/Time column is automatically placed under the Sort
Columns section with descending order selected. If you do not wish to sort by
Date/Time, simply click on that column listing and drag it back to the left side of
the screen under Columns Available For Sorting.

To edit a record, highlight the record to be edited, click Record r;> Edit Record in
the menu bar or click the Edit toolbar button.

Different viewers have different editable items. Results that have been
successfully sent to the LIS or HIS have only an editable Comment. Results
marked as Pending or In Progress cannot be edited.

The Patient ID, Patient Name, Operator 1D, Comment, Interface Comment
and Order Number can be edited in the Resulis Viewer. Use the Tab key or
the mouse to move across the line. The original Patient and Operator IDs will
appear along with the edited |IDs in the Details window.

Different viewers have different lists from which to select for a search based on the
data presented. Click Record o> Find... on the menu bar or click the Find toolbar
button. Selecting Sort before finding before clicking OK will present the records
in ascending order for the value after the first record matching the search is found.

Type on the Value line the desired parameter then highlight that parameter and
click OK to find.

Patientip. -
Fatient Name
Operator ID
Date - Time
Location

Department
Comment

Interface Comment
Order Number
Serial Mumber
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Printing Selected
Records

Send Selected
Records

Trending Results

Example of a
Result Trend by
Serial Number

QC Codes Viewer

Rev. Date: 07/18/06

With a Data Viewer open, highlight the records to be printed, click Record = Print
Selected Records or click the Print toolbar button.

With a Data Viewer open, highlight the records to be sent, click Record = Send
Selected Records or click the Send toolbar button.

Results records in the Results, Control Results, Cal/Ver Results, Proficiency
Results and Unsent Results Viewers can be selected for Trend reports. Trends
can be performed on Patient ID, Control Lot Number, Calibration Verification Kit
Number, Proficiency ID, Operator ID, Analyzer Serial Number or by a selection of
records.

With the Data Viewer open, click Record &> Trend, then the trend option from the
menu bar or click the arrow beside the Trend toolbar button and click the desired
trend option. Up to 25 records are presented from oldest to newest data.

To trend by selection, highlight the records to be included in the trend report
then perform the Trend function.
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All Quality Check Codes are listed in chronological order. To add a comment, click
the record, then Record £)> Edit Record on the menu bar or click the Edit Record
toolbar button. To sort the Quality Check Codes by type, click the Quality Code
column header. To list again in chronological order, click the Date-Time column
header.

Note: Panelis a binary code for the cartridge types.
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Electronic All Electronic Simulator results, both external and internal, are listed in
Simulator Viewer chronological order with the newest result at the top of the screen. To view all
simulator results together for each analyzer, click the Serial Number column
header to sort the analyzers by serial number or use the Find... option and
sort for one analyzer. To list in chronological order again, click the Date-Time

header.
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To view the actual readings taken during the Electronic Simulator check, click

Record 2> View Extended Simulator Report... Note that the Simulator ID and
Probe Delta columns can be viewed in the screen above by scrolling to the right.
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Unsent Records This viewer is available only if an external interface installed by i-STAT is enabled

Viewer in the Central Data Station Customization function. This data viewer displays
records that have not been sent from the Central Data Station to an external
computer system, such as an LIS. The incorrect information can be corrected
using Edit and the corrected record resent.

Unsent results can be removed from the viewer by highlighting the record,
clicking on Record > Mark Selected Records as Sent, or by pressing the F8
Key.
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Values
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Sent Column Definition Can the record

Value be resent?

No This is the initial value when a data Yes
record is entered into the database.

Pending This value means that the record is in No
the queue waiting to be processed by
the Interface.

In Progress This value means that the record is No
currently being processed by the
Interface.
Forwarded (HL7 | This indicates that the Record has been Yes

Protocol Only) | forwarded to the receiving system but
has not yet received the Application
acknowledgement indicating whether
or not the LIS successfully processed
the record.

Yes This value means that the i-STAT No
Interface application successfully
processed the record.

For Data File Protocol Only:

*  “Yes means that the Data File was
successfully created in the ¢\
istat32\send directory. It does not
necessarily mean that the record
was processed by the LIS.

e |tis up to the receiving system to
provide a status update to the CDS
(See INTER32-SPC-011.doc)

Unsuccessful | This value means that the record send Yes
was not successful. The Interface
Comment will provide some limited
information as to why the record send
was unsuccessful.
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DATA EXPORT

A data export option is available in the following areas of the Central Data
Station application:

a. Data Viewers

b. Reports

c. Trend report, and

d. the Extended Simulator report screen

To access this option from any of the Data Viewers or Reports, click on Window
> Export. From a Trend report or the Extended Simulator report screen, click
on the Export data... button at the bottom of the report. A dialog box will then
appear on the screen. Choose the file destination location and the type of file
you want the exported data saved as from the drop-down menus, then type in
the File Name and click on Save.

“3 My Documents

f@ﬁMy Pictures

Note: Users can be blocked from or allowed access to this data export feature
through the User Administration Workspace by using the check box
“Export data in patient data viewers” under the Security Options for
Selected Profile section.

Access to the instrument and location workspace
Access to the operator workspace

Access to the database maintenance workspace
Access to the inventary workspace

Access to the customization workspace

Access to patient data viewers (results and unsent)
I Edit data in patient data viewers

" Send data in patient data viewers

M View details and print in patient data viewers

M Export data in patient data viewers

| T"  Access to non-patient data viewers

| M Access to the configuration screen
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Download Monitor

Rev. Date: 07/18/06

The download monitor quickly identifies the download status of all locations and
any locations that have instruments out of download compliance.

The upper portion of the monitor shows the last time an analyzer from the
listed locations was downloaded. These columns can be sorted by clicking the
column heading.

The maximum time allowed between downloads from the instrument to the CDS
is defined under Download Criteria in the Instrument/Location workspace.
The download status of each location is recorded in the Download Monitor.
The Requires Download column indicates how many of the total number
of analyzers reporting to a location have exceeded the Download Criteria.
Clicking the location will open the Instrument and Location workspace where
noncampliant analyzers will be highlighted.

The monitors are updated or refreshed according to the schedule selected during
the customization of the CDS. The data can be manually refreshed by clicking the
Refresh toolbar button or by pressing the F5 key.
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Interface Monitor

The Interface Monitor accessed via the menu bar functions with an interface
installed by Abbott Point of Care Inc.. To access the the interface monitor for an
interface installed by a third party, click on the Interface Manager button in the
tray at the bottom of the screen.

The Interface Monitor identifies quickly the status of the Interface to an external
computer. The number of pending results is shown as well as any exceptions in
the last 72 hours. Clicking an exception takes you to the Unsent Results viewer
to address the exception.
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Overview

Reagent
Management

Rev. Date: 07/18/06

Reports for managing the point-of-care testing process are available from the
CDS program. Three reports can be generated: Reagent Management, Method
Competency and Method Compliance. These show information summarized by
operator, location, department, or analyzer. Reports can be printed.

This is a report of cartridge usage by Department or Location. Select a date
range for the report. Data in reports, with the exception of “Operator”, can be
sorted by clicking on the column headers. By Operator data is pre-sorted by
department. Select a report by Reagent Usage by Department, Reagent
Usage by Location, Reagent Usage by Operator, or Reagent Usage by
Analyzer, and then select either All Locations or All Departments, or select
one Location or one Department from the drop down menu. Select the desired
result types (Test, Control, Car/Ver, Proficiency) and then click the OK button.

0241042004
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Method
Compliance

This is a report of exceptions of policy and procedure for cartridge testing by
Department, Location or Operator. This information is available when there is
an interface to an external computer.

Select a date range for the report. Select a Report by Department, Location,
or Operator, then select All Locations or All Departments or select one
Location or Department from the list. Click on Display operator names if
desired. When Method Compliance by Operator is selected, operators will be
listed by department. Select the filtering criteria for the report and then click the
OK button.
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Method
Competence
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This is a report of Quality Check Code occurrence for cartridges by Department,
Operator, Location or Analyzer.

Select a date range for the report. Select a Report by Department, Location,
Operator, or Analyzer and then select All Locations or All Departments or
select one or more Locations or Departments from the list. Click on Display
operator names if desired. Select the filtering criteria for the report. Then click
the OK button.

When Quality Check Codes by Department is selected, operators will be listed
by Department.

.

A legend mapping individual code numbers to their respective quality check
code categories is available for viewing. To access this legend:

1

2.

Create the desired Quality Check Code report.

With the report still on the screen, click on Report > View QC Codes
by Category... The following dialog will appear for viewing or printing.

{ Guolty Creci Code Catepory Guslty Chack Codes

2,13.14,19, 20,22, 23,25, 26, 27, 28,29, 32, 33, 40, 41, 44, 45, 56, 48, 49, 50,51, 52,53, 54, 55, 56, 7, 55, 58,€0,6
A Eremenment ,2,5.4,5.5,7,8,9,10,11,15,15, 17,18, 55

Emndguhndiw £, 2442, 43,47,127,178,140, 141
A vertied Carise ¥, 37

i e 1 Postion Sengle |1, M
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For details of these Quality Check Codes, see the Technical Bulletin: Analyzer
Coded Messages.
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SYSTEM

Customization:
Central Data
Station Settings

Customization:
i-STAT Analyzer
Settings

AutoSend

Print Option

Configuration of the CDS can be viewed.

Customization profiles of the i-STAT analyzers can be viewed.

When enabled, data will be transmitted automatically from the CDS to the LIS or
other information management system when received by the CDS. If AutoSend
is not enabled, results can be sent to the LIS manually. Highlight the records

to be sent in the appropriate Data Viewer Results viewer then click Record 2
Send Selected Records. If AutoSend is enabled, it will be checkmarked under
the System option on the menu bar. If an external interface is not enabled,
AutoSend will appear in grey typeface.

A Printer Dialog box has been added so that when Print is selected from the
menu, the user can choose from a list of installed printers. This allows the user
the option to utilize their own network printer. To access this feature, you must
perform one of the following:

a. Click on Main > Print, or

b. Click on Records > Print Selected Records

Add Printer
2§ HP LASERJET 1200
i Cannon S 520
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HELP

Technical Support  Phone number for your Customer Support Representative.

About... Software version of the Central Data Station.

WINDOWS OPERATING SYSTEM AND LANGUAGE SUPPORT

Windows Version/

Service Pack

Windows

" Supported CDS Language(s)

Language

NT 4.0, SP6a English English
2000 Professional, SP4 English English, German, ltalian, Spanish,
Swedish
2000 Professional, SP4 German German, English
2000 Professional, SP4 [talian Italian, English
2000 Professional, SP4 Spanish Spanish, English
2000 Professional, SP4 Swedish Swedish, English
XP Professional, SP2 English English, German, Italian, Spanish,
Swedish
XP Professional, SP2 German German, English
XP Professional, SP2 Italian Italian, English
XP Professional, SP2 Spanish Spanish, English
XP Professional, SP2 Swedish Swedish, English

During the initial installation or upgrade of the CDS 5 software, all U.S.
customers should choose “English” when the language choice drop down menu

appears. Failure to do so will result in the following consequences:

1. If the wrong language was chosen during the initial installation of the
Version 5 software, all CDS screens will appear in the language chosen.

Contact your i-STAT Support Representative if this has occurred.

2. If the wrong language was chosen during an upgrade of the CDS 5
software, the i-STAT installation instructions will appear in the language

chosen, but the CDS screens will remain in English.
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